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About this Guide

Audience This user guide is for laboratory staff operating, maintaining, and analyzing data
using the Applied Biosystems® Attune® Acoustic Focusing Cytometer.

@ IMPORTANT! For instructions on using the Applied Biosystems® Attune®
Auto Sampler, refer to the Applied Biosystems® Attune® Auto Sampler User
Guide (Part no. 4479066) and the Applied Biosystems® Attune® Auto Sampler
Quick Reference Guide (Part no. 4479067)

Table of Acronyms The following table explains the acronyms used in the Applied Biosystems® Attune®
Acoustic Focusing Cytometer User Guide.

Acronym Definition
ADC Analog-to-Digital Converter.
Br Relative background level of detection channel.
BL1-BL3 Detectors which measure the output from the 488-nm laser (blue)

on the blue/violet configuration.

BL1—BL4 Detectors which measure the output from the 488-nm laser (blue)
on the blue/red configuration.

%CV Percent coefficient of variation = standard deviation/mean x 100%.
It is a measure of variation in signal intensity generated as
particles pass repeatedly through the laser beam, and is expressed
as a percentage of average signal intensity.

FSC Forward scatter.

%HPCV Percent half-peak coefficient of variation.

MESF Molecule of equivalent soluble fluorophore.

MFI Mean Fluorescence Intensity as described by the mean ADC value
for a given bead intensity population.

PMT Photomultiplier tube.

PMTV PMT voltage setting.

RL1—RIL2 Detectors which measure the output from the 638-nm laser (red)
on the blue/red configuration.

SD Standard deviation.

SIP Sample injection port.

SSC Side scatter.

VL1-VL3 Detectors which measure the output from the 405-nm laser (violet)

on the blue/violet configuration.
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How to Obtain Support

For the latest services and support information for all locations, go
to www. lifetechnologies.com/support.

At the Technical Resources page, you can:

e Search through frequently asked questions (FAQs)

e Submit a question directly to Technical Support

¢ Order Life Technologies user documents, Safety Data Sheets (SDSs),
certificates of analysis, and other related documents

¢ Download PDF documents

¢ Obtain information about customer training

¢ Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax
numbers to contact Life Technologies Technical Support and Sales facilities.

When contacting customer support for instrument troubleshooting, provide the
instrument model and the instrument serial number. Convey to the technical
support any error messages that were displayed on your instrument and any
troubleshooting that you have already performed

(see Appendix E: Troubleshooting).

User The guides listed below are shipped with the Applied Biosystems® Attune®
Documentation Acoustic Focusing Cytometer.
Guide Part no.
Applied Biosystems® Attune® Acoustic Focusing Cytometer Quick 4453802
Reference Guide
Applied Biosystems® Attune® Acoustic Focusing Cytometer User Guide 4453328
Applied Biosystems® Attune® Auto Sampler Quick Reference Guide 4479067
(optional)
Applied Biosystems® Attune® Auto Sampler User Guide (optional) 4479066

Additional resources are available on the Flow Cytometry Technical Resources
page. Go to www.lifetechnologies.com, then search for “Flow Cytometry” to
open this page. There you can find protocols, application notes, and tutorials.
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Safety Information

<® Note: See “Appendix C: Safety” on page 68 for the complete the chemical
=l or instrument safety information.

Safety Alert Words Four safety alert words appear in Life Technologies user documentation at points
in the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

@ IMPORTANT! - Provides information that is necessary for proper
instrument operation, accurate installation, or safe use of a chemical.

CAUTION! - Indicates a potentially hazardous situation that, if not
avoided, may result in minor or moderate injury. It may also be used to
alert against unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not
avoided, could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not
avoided, will result in death or serious injury. This signal word is to be
limited to the most extreme situations.

> B> P

Except for IMPORTANT! safety alerts, each safety alert word in a Life
Technologies document appears with an open triangle figure that contains a
hazard symbol. These hazard symbols are identical to the hazard symbols that are
affixed to Applied Biosystems® instruments (see “Safety Symbols” on page 151).

SDSs The Safety Data Sheets (SDSs) for any chemicals supplied by Life Technologies are
available to you free 24 hours a day. For instructions on obtaining SDSs, see
“SDSs” on page 160.

@ IMPORTANT! For the SDSs of chemicals not distributed by Life
Technologies contact the chemical manufacturer.
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1. Daily Routine

Workflow

Before You Begin
Startup
Check Fluid and Waste Levels
Fill the Fluid Tanks
Power On the Cytometer and Computer
Launch the Software and Run Startup Function
Run Samples (See Chapter 2)
Shutdown
Check Fluid and Waste Levels

Run Shutdown Function

@ IMPORTANT! Although the daily Startup and Shutdown procedures are
automated and require minimal user input, we recommend that you
familiarize yourself with the instrument, its operating principles, and the
software user interface by reading Appendix C: Instrument Description
and Appendix D: Attune® Cytometric Software Description before
starting your experiments.
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Before You Begin

Required Solutions Attune® Focusing Fluid - is a buffered, azide-free support/carrier reagent for
transporting particles through the capillary assembly. It contains a
preservative and detergent designed to minimize bubble formation.

e Attune® Wash Solution - is a ready-to-use solution for removing cellular
debris and dyes from the fluidics system of the instrument.

e Attune® Shutdown Solution — is a 10X solution that prevents bubble
formation in the fluidics system of the instrument. Prepare a 1:10 dilution of
the shutdown solution in deionized water and add it to the water tank.

¢ 10% bleach solution in deionized water — decontaminates the fluidics lines.
Prepare this solution fresh daily and use during the shutdown procedure.

¢ Deionized water — used for diluting Attune® Shutdown Solution and bleach,
as well as for long-term storage of the instrument.

@ IMPORTANT! 10% Bleach is defined as a 1 in 10 dilution (1 part bleach to
9 parts water) of 5.25% sodium hypochlorite in water. This gives a final
concentration of 0.5% sodium hypochlorite equivalent to 5000 ppm of
available chlorine.

@ IMPORTANT! Reagents may be stored at colder temperatures, but
running the instrument with cold reagents (<15°C) will affect the data
quality. Before you run the instrument, ensure that all fluid
temperatures are at least 15°C.

10 Attune® Acoustic Focusing Cytometer User Guide



Startup

Check Fluid and
Waste Levels

Fill the Fluid
Tanks

During Startup, the Attune® Acoustic Focusing Cytometer:

Warms the lasers to operating temperature
Initializes the pumps
Primes the instrument fluidics

Informs the user of System Status (Ready, Attention, Clog, etc.)

The Startup function ensures that all fluidic lines are clean, the fluidic lines and
the system’s two pumps are filled with fresh focusing fluid, and the lasers are
warmed to operating temperature.

Check the levels in the fluid tanks (see page 87 for the location of the fluidics
compartment).

If empty, fill the focusing fluid, wash solution, and shutdown solution tanks.

@ IMPORTANT! Reagents may be stored at colder temperatures, but
running the instrument with cold reagents (<15°C) will affect the data
quality. Before you run the instrument, ensure that all fluid
temperatures are at least 15°C.

If full, empty the waste tank.

@ IMPORTANT! The Attune® Acoustic Focusing Cytometer must be
powered off or in stand-by mode before refilling the fluidics tanks.

Press the metal release buttons to free the tubing and sensor cables from the
instrument, and remove the tank.

Unscrew the lid, and fill the tank with the appropriate solution. The focusing
fluid tank has 1 L capacity, and the wash and shutdown solution tanks have
500 mL capacity each. Do not overfill the fluid tanks.

Screw the lid back on without over-tightening it.

Replace the tank by sliding it into the appropriate slot and plugging the
tubing back into instrument.

@ IMPORTANT! For all fluid tanks, always connect the tubing connector

first. Connecting the sensor cable while leaving the tubing disconnected
may result in increased back pressure and damage to the fluidics system
and introduction of air into the system.

Attune® Acoustic Focusing Cytometer User Guide 11



Power On the
Cytometer and
Computer

Launch the
Software and Run
Startup Function

12

Note: The fluid levels are monitored via floating sensors in all fluidics
tanks. When the fluid level is low or the waste bottle is full, the software
displays the appropriate warning message. The blue LED on the affected
fluid tank will also pulse.

To resume the run, follow the displayed instructions and click OK.

Power on the Attune® Acoustic Focusing Cytometer by pressing the switch
(h) located on the upper-right corner above the fluidics door.

Power on the computer and monitor.

Wait for the computer to boot.

Log in to Windows. The default credentials are:
e User name: INSTR-ADMIN

e Password: INSTR-ADMIN

®

Note: You can power on the instrument and the computer in any order.

Launch the Attune® Cytometric Software.

If the daily Startup function has not been performed, Startup displays in the
upper-right corner. If the daily Startup function has already been performed,
then Shut Down displays in the upper-right corner.

Either, click Startup on the upper-right corner of the Login screen, then
log into the software by entering your Username and Password.

Or, if Shut Down displays in the upper-right corner, enter your username and
password, then click Login.

Note: The default username and password for the software are “admin”
and “password,” respectively. After logging in, assign a password to the
administrator account as soon as possible. To create additional users,
see Software Administration on page 133.

The Startup prompt screen appears and provides instructions to perform the
Startup operation.

The Attune® Cytometric Software automatically turns on the lasers and
instrument systems, initializes the pumps, and primes the fluidics lines. The
status window displays the Startup operation being performed.

O After the Startup function is completed and no system errors are
encountered, the Status bar displays the Ready icon.

q If any system errors are encountered during the Startup, the status bar
(= displays the Alarm icon.

®

Note: A flashing green light on the instrument indicates that Startup is
under way, and a continual green light indicates that the instrument is
ready.
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IMPORTANT! When you power on the instrument, always allow at least
@ 10 minutes for the lasers to reach operating temperature before you run
samples.

Shutdown

The Shutdown function of the Attune® Cytometric Software facilitates the
automated shutdown of the instrument. The function ensures that all sample fluid
and dyes have been removed from the system the fluidics lines and the two
pumps have been decontaminated and filled with Attune® Shutdown Solution to
prevent the formation of salt crystals.

The automated shutdown procedure can take up to 30 minutes.

@ IMPORTANT! Perform the following shutdown procedures at least once a
day, even if the instrument is intended for continuous use. Proper cleaning
of the instrument ensures its consistent and accurate operation.

ii CAUTION! BIOHAZARD. Cytometer hardware may be contaminated by
biohazardous material. Using fresh 10% bleach solution in deionized water
is the only procedure we recommend for decontaminating the cytometer.

@ IMPORTANT! 10% Bleach is defined as a 1 in 10 dilution (1 part bleach to
9 parts water) of 5.25% sodium hypochlorite in water. This gives a final
concentration of 0.5% sodium hypochlorite equivalent to 5000 ppm of
available chlorine.

Check Fluid and 1. Check the levels in the fluid tanks (see page 87 for the location of the fluidics

Waste Levels compartment).

2. Ensure that the wash solution tank is at least half-full. If empty, fill the tank
with Attune® Wash Solution (see page 11 for instructions on filling the fluid
tanks).
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Run Shutdown
Function

Perform System
Flush

14

IMPORTANT! Powering the instrument on and off within 30 minutes can

@ decrease the laser lifetime. The Shutdown function powers off the laser
and the instrument automatically. If you interrupt the script, you will need
to force exit, then restart the script and let it run to completion.

1. Log Out of the Attune® Cytometric Software.
Click Shut Down.
The Shutdown prompt screen appears.

2. Select Standard for 10 wash cycles or Custom number of cycles to enter the
desired number of wash cycles. Click Next.
The software provides instructions to perform the shutdown operation.
The Attune® Cytometric Software automatically performs the shutdown

operation and the shutdown status window displays the shutdown function
being executed.

3. At the end of the shutdown operation, the Attune® Cytometric Software
automatically powers down the Attune® Acoustic Focusing Cytometer.

@ IMPORTANT! If you cancel the shutdown, allow at least 10 minutes for
the lasers to reach operating temperature before running any samples. You
will also need to re-run Startup.

@ IMPORTANT! If you intend to leave the Attune® Acoustic Focusing
Cytometer in the shutdown state for longer than two weeks, perform
system flush and leave the instrument in deionized water to prevent salt
crystals from clogging the fluidics system.

Perform system flush if you intend to leave the cytometer shutdown for longer
than two weeks.

1. Replace all fluidic containers (focusing fluid, wash, and shutdown tanks)
with deionized water.
2. Run Startup.

3. Run the Shutdown function using deionized water on the SIP instead of
bleach.
4. Empty all fluidic tanks and allow to dry.

Attune® Acoustic Focusing Cytometer User Guide



2. Running Samples

Workflow

Before You Begin
Sample Requirements
Startup
Execute Performance Tracking Function
Verify Optical Configuration
Inter-User Wash Procedure

Create an Experiment

Optimize the Experiment

Calculate Compensation

Collect Data

Attune® Acoustic Focusing Cytometer User Guide
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Before You Begin

Sample
Requirements

Startup

Performance Test

Verify Optical
Configuration

16

Before starting an Experiment, you should be familiar with:

e Attune® Acoustic Focusing Cytometer Startup, Performance Tracking, and
Shutdown procedures

e Attune® Cytometric Software Workspace and Experiment Explorer.

* You need at least 220 pL of sample in a single cell suspension.

e The Attune® Acoustic Focusing Cytometer is designed to handle samples in
tubes ranging from 17 x 100 mm to 8.8 x 45 mm.

e The method used to prepare a specimen depends on the sample type and the
assay desired.

¢ In general, the maximum recommended sample concentration for analysis is

1 x 10° cells/mL. If the concentration of your sample is > 1 x 10° cells/mL, dilute

it down prior to running it on the Attune® cytometer.
¢ The maximum recommended sample concentration for the Standard 500

uL/minute and 1,000 uL/minute collection rates is 5 x 10° cells/mL.

Perform the Startup procedures as detailed on page 11.

Perform the Performance Test procedures as detailed on pages 59-61, and verify
that the Attune® Acoustic Focusing Cytometer is in good working order.

Check the optical layout of the cytometer to verify that the filters are appropriate
for the sample type and fluorophores you are using.

Place your mouse over the icon in the lower-left corner to verify the optical
configuration. Either Blue/Violet or Red/Blue displays:

Blue/Violet Red/Blue

Qe O 00

If you need to change the optical configuration:

1. Click Options (-ﬁ') shortcut button in the Quick Access toolbar.

2. Select Configuration, then select the Laser Color Configuration.
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General

m Attune® Hardware Configuration
Administrator

User Management Laser Color Configuration
Syl
tyles () Blug/violet Lasers
Resources (%) Red/Blue Lasers

Configuration

3. Click OK. The software prompts you to confirm:

=  Attune® Cytometric Software

Laser Configuration has changed.
You will be logged out and will need to log back in for the changes to take effect.

Select OK to continue, or Cancel to return to Options dialog.

4. Click OK to continue.

5. Log in to the software.

Inter-User Wash We recommend that you sanitize the system between users:
Procedure 1. At standard 1,000 uL/minute collection rate, run 1 mL deionized water.
2. Repeat with 10% bleach solution.

3. Repeat with deionized water.

@ IMPORTANT! 10% Bleach is defined as a 1 in 10 dilution (1 part bleach to
9 parts water) of 5.25% sodium hypochlorite in water. This gives a final
concentration of 0.5% sodium hypochlorite equivalent to 5000 ppm of
available chlorine.
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Create an Experiment

Using a Blank
Template

18

This section explains how to create a tube experiment. To create a plate experiment,
refer to the instructions in the Attune® Auto Sampler User Guide (Part no. 4479066).

To run your samples and collect cytometric data, you need to create an Experiment in
the Workspace. The Attune® Cytometric Software allows you to:

e Create an experiment using a blank template

¢ Create an experiment using a pre-populated template

¢ Create an experiment from the Experiment Explorer using the default Workspace
e Duplicate a saved experiment in the Experiment Explorer

You can perform these functions from the Main Menu or by using the Experiment
Explorer.

1. From the Main Menu screen, click Blank Tube Experiment.

INew Experiment

No template Mo template No template No template
' - defined defined. defined defined
= I Click here to ssiact one. Giick here to salect one. Click here to select one. Ciick here (o salect one
_— ..I

Click here to select one. Click here to select one Click here to select one. Click here to select one Click here to select one.

No template Mo template No template MNo template Mo template
defined defined defined defined defined B <1
2

Workspace with a blank work area opens, and the new experiment is
displayed on the Experiment Explorer.

E, Note: By default, the new Experiment displayed on the Experiment
—  Explorer is labeled with the date and time it is created and contains no
Specimens or Samples.

I 02-18-2010 05.42 PM

To rename, select the Experiment and then press F2. Or, right-click the
Experiment and choose Rename Experiment.

2. To add a Specimen to your experiment, right-click the experiment and choose
New Specimen.

3. Toadd a Sample to the Specimen, right-click the specimen and choose
New Sample.

E Note: To rename Experiments, Specimens, and Samples, right-click and
—  choose Rename. Alternatively, highlight and then press F2.
You can also rename Experiments, Specimens, and Samples by right-
clicking and choosing Properties, and changing the name in the dialog box
that opens.
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4. Toinsert a Plot to your Work Area, select the Sample in the Experiment Explorer,
then choose the type of plot from the Insert tab.

WA

Histogram Dot Density
Plot Plot Plot

Plots

Vit

x__ Note: For an overview of different types of plots, see “
Plots” in “Appendix B: Technical Overview” on page 44.

5. To change the Parameter and/or the Scale, right-click directly on the plot axis.

Red Laser - Sample

200 I

Time

FsC-A
150 S5C-A
BL1-A
BLZ-A
BL3-A
BL4-A
RL1-A
RLZ-A
F5C-H
S5C-H
BL1-H
BL2-H
0 BLI-H
BL4-H 5 6 7 8

RL1-H

RLZ-H

FSC-W

SSC-W

BL1-W

v BLZ-W

BL3-W

BL4-W

RL1-W

RLZ-W
Cut Chrl+x
Copy cirl+C

BL2-W
=]
=

50

Delete D&l
Duplicate

Save As...

Scale r

Customize...
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Using a 1. From the Main Menu screen, double-click Template you want to use.
Pre-Populated e
Template | | S = - —
4 :A..l, lLl s ’.. | Y e £
0 = L ERIST :
i P e |

Template [ Template ) Browse Templates

Tempiate F Template 6 Template H

Pre-populated Workspace opens, and the Experiment Explorer displays the
new Experiment created from the template.

Alternatively, from Experiment Explorer, right-click My Experiments, and
choose New Experiment Using Template.

\@ Note: You can customize any of the objects displayed on the Work Area by
— right-clicking on the object. To change the parameters and/or the scale,
right-click directly on the axis.

New Experiment 1. From Experiment Explorer, right-click on e B rr e
from the the My Experlments, then select New Tube Mew Tube Experiment using Template...
Experiment Experiment.

Mew Plate Experiment..,

Explorer

New Plate Experiment using Template...
New Folder

Import Tube Experiment...

Import Plate Experiment...

Open My Experiments Folder

2. Enter the experiment name, and the number of specimens and samples
desired. The default Workspace and default Instrument Settings are selected.
Confirm that the settings are correct for your experiment, or change as
required. Other Workspaces and Instrument Settings for the experiment can
be selected in this at this point.
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& Experiment X
Experiment

You can use the following options to add or update an experiment.

Experiment Name: | 10-27-2010 05 02 M ‘

Description: [ ]

Time Created: 10/27/2010 5:02 PM
Time Modified:

Workspace: [:\Program Fies\ppied Biosysterms\v1. L. 20\Attune\UserstacminiTem]
Instrument Settings: ‘C:\ngram Files\Applied Biosystems\vl. 1 zn\Amne\Userswmin\Tem|

Notes:

Samples
Create ‘Specimen(s) for this Experiment
Create [ 1| Sample(s) per Specimen

“ —

Note: For information on setting the default Workspace and Instrument
Settings, see “General Options” on page 136.

Duplicating a 3. From Experiment Explorer, right-click on
the Experiment you want to duplicate, and
choose Duplicate Experiment.

MNew Specimen
Saved Experiment

Duplicate Expeniment
Delete Experiment

Rename Experiment

Export Experiment...
Export FC5 Filefs)...
Export Statistics...

Print...
Open Expenment Folder

Experiment Properties

4. Check the desired options in the Duplicate | buplicate Experiment Options ==
Experiment Options dialog box, then click Duplicate Experiment Options
OK Use the following options to select what to duplicate.
Workspace opens and displays the same Compensation Settings
objects as the duplicated experiment, but ] Local Instrument Settings
Wlthout the data. [ Local Workspaces
——

The Experiment Explorer frame displays the duplicated experiment, but the
Sample icons indicate that they contain no data.
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Optimize the Experiment

Before you can record data for a sample, you need optimize your Experiment.
Experiment optimization involves fine-tuning the PMT voltages, compensation,
and threshold settings for each dye and sample used in the experiment to adjust
the positions of populations of interest on scale for the scatter and fluorescence
parameters.

& Note: We recommend that you optimize each individual experiment prior
—  to collecting data. If compensation is to be applied, ensure that all Voltage
settings (except for FSC and SSC) have been finalized for all samples prior
to recording any data. Compensation applied to samples that have
voltages that are different from those used in the compensation setup may
produce erroneous results.

Before You Begin 1. If the experiment requires compensation, prepare the necessary compensation
controls. You need an unstained or isotype-labeled control and single-stained
controls for each fluorophore (i.e., compensation beads or cells) you are using
for compensation.

Create an Experiment in the Experiment Explorer.

Create the necessary Specimens and Samples.

To create a Specimen, right-click the Experiment and select New Specimen.
To create a Sample, right-click the Specimen and select New Sample.
Create a Workspace with the plots appropriate for your experiment.

To optimize instrument settings for compensation control samples, open the
compensation setup guide as described on page 26 and select the necessary
parameters for compensation.

Compensation control samples are created within the Compensation ()
module in the Experiment Explorer. See pages 23-25 for details about
optimizing compensation controls.

6. If no compensation is necessary, you can optimize the instrument settings
within the Workspace of the Sample in the Experiment Explorer. The
procedure for optimizing samples is similar to that described for
compensation control samples (See pages 23-25).

7. Adjust all voltages to put the population of interest on scale in all necessary
channels. It is recommended that voltages are set to maximize the signal to
noise.

8. You can adjust the threshold and voltages using the Instrument Configuration
tab on the Collection Panel. Alternatively, you can use Instrument Settings in
the View tab, which gives you the additional ability to rename parameters.
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Optimizing
Instrument
Settings for
Compensation
Controls

Optimizing
Instrument
Settings for
Unstained Control

Attune® Acoustic Focusing Cytometer User Guide

We recommend that you optimize the Instrument Settings for compensation
controls in the Compensation Workspace. See Compensation Setup on page 26.
Optimize Instrument Settings for the unstained control and for each of the
single-stained controls as follows:

4 | 05-15-2012 11 17 AM
L_& Global Workspace
& Globkal Instrument Settings

Double-click the Unstained Sample in the
Compensation view in the Experiment Explorer.

The Workspace for the Unstained Sample contains

4 _."' | Compensaticn

one SSC vs. FSC plot containing a polygon gate and

i [A4] Unstained Control

histogram plots for each of the fluorescent
parameters selected during the compensation
setup.

Install the unstained control on the tube lifter.

Sample Dispensed

Enter the Acquisition Volume, then set the Flow
Rate by adjusting the slider bar.

Acquisition Volume: 50wl (170 uL total draw volume)

igh sensitiiy
For setup, you can conserve your sample by ¢ B
running the cytometer in Standard mode at a 25 pL

per minute collection rate.
Click Run.

Events will appear in the FSC vs. SSC plot. You can obtain data in real-time
without saving them to a file.

@ IMPORTANT! DO NOT click Record at this point.
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10.

Adjust the FSC voltage to
place the population on
scale by sliding the FSC
slider bar up or down.

Alternatively, you can
type a specific numerical
value in the settings
window above each
channel.

Adjust the SSC voltage to
place the population on

scale by sliding the SSC
slider bar up or down.

Adjust Threshold on
instrument control panel
to remove unwanted
events and background.

Set the scatter gate on the

population of interest so
that the fluorescence
histograms are reflective
of the population for
which you are
optimizing your
voltages.

Adjust the Fluorescence
Channels to place your
unlabeled sample in the
appropriate area in the
plot (generally around
10° for unstained
control).

Remove the unstained
control from the sample
injection port.

Instrument Configuration - I X
Threshold (x1000)
FSC SSC BLL BL2 BL3 VL1 V2 VI3

100 10 0[] 10 10 10 10 10

I e e s O e O O |

Tnstrument Configuration »1x
Threshold (x1000)

FSC SSC BLI B2 B3 B4 R R

100 0

O 0 OO0 0000

(o JC3on Jton [Lton YL ton JUson [ 10 i )

Voltage (mv)
FSC S5C BL1 BL2Z BL3 VLI VL2 VL3

160C| | 210C| | 230C| | 220C| | 255C) | 125C) | 1950 | 220C

L

[} Collection Panel| g, Instrument Configuration ‘

Blue/Violet
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Voltage (mV)
FSC SSC BL1 BL2 BL3 B4 RL1 RL2

1600 | 2100 | 3300| | 2200| | 2550| | 2550| | 1250| | 1850

A Collaction Pane D,im:rumn:C:ﬂﬂ:lu'm-cn
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Optimizing After you have optimized the instrument settings for | Eweriment Bxplorer S

Instrument the unstained control, optimize the instrument 4 8 myEpemens
Settings for controls for each of the single-stained controls. =) Bxperiment 1
IZ) Experiment 2
Single-Stained 1. Stay on the Unstained compensation control. ‘ [ Workspace
Controls 2. Install the first single-stained control on the tube [ trstrument Settings
lifter. For the Blue/Violet configuration, 4 [l Compensation

histograms are ordered as VL1-3, then BL1-3. For [+
the Blue/Red configuration, the histograms are A w1
ordered as BL1-4, then RL1-2. A vz

3. Using the same optimization procedure, adjust e
BL1

X
-
the instrument settings and set the scatter gate on -
X

the population of interest. - zf
4. For each compensation control sample (i.e., 4 4 .‘Sl;‘eciﬂen
fluorophore), observe the corresponding ¥ semple

histogram to optimize the voltages.

5. Perform the optimization procedure for all single-
stained controls.

6. After you have optimized instrument settings for
each single-stained control.

@ IMPORTANT! Once you click Record on any of the compensation
controls within the compensation setup, the Instrument Settings for all
fluorescent channels will be grayed out and cannot be changed. It is critical
that you optimize voltages prior to recording any sample or any
compensation controls.

E Note: The Scatter Gate defined in the Unstained control can be applied to
—  all other compensation controls by right clicking the gate (R1) and selecting
Apply gate shape to all controls...

R1

£ Apply gate shape to all controls [}

Customize,..

E Note: The Attune® Cytometric Software automatically executes the Rinse
—  function each time the tube lifter is pushed down to remove the sample
from the sample injection port. This ensures that the fluidics system of the
instrument is flushed and any remaining sample is removed to minimize
carryover.
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Calculate Compensation

Compensation
Setup

26

Fluorophores emit light over a range of wavelengths. Although optical filters limit

the range of frequencies measured by a given detector, when two or more

fluorophores are used in an experiment, there is often an overlap between the
wavelength ranges. Compensation is the mathematical method used to correct the

overlap of one fluorophore’s emission into another fluorophore’s emission
channel.

The Attune® Cytometric Software calculates the compensation settings
automatically as it guides you through the process.

IMPORTANT! Once you click Record on any of the compensation

@ controls within the compensation setup, the Instrument Settings for all

fluorescent channels will be shaded gray and cannot be changed. It is
critical that you optimize voltages prior to recording any sample or any
compensation controls.

Select Compensation from the main menu, then select Compensation Setup.

Alternatively, double-click Compensation or right-click and select
Compensation » Compensation Setup under the same folder that contains
your optimized Experiment in the Experiment Explorer.

Compansation Matrix...

LE"] v Remove Compensation

Compensation Setup dialog box opens. The control samples vary by
configuration. The Blue/Violet configuration control samples are Unstained
Control, VL1, VL2, VL3, BL1, BL2, and BL3. The Blue/Red configuration
control samples are Unstained Control, BL1, BL2, BL3, BL4, RL1, and RL2.

u . Compensation Setup E| ®  Compensation Setup E|

Compensation Setup Compensation Setup

Use the following options to set up compensation Use the following options to set up compensation.

Compensate on
(Sarea () Height

For these control samples
[“lunstained contral

Compensate on
(@ area () Height

For these control samples
Unstained Control

v [#lBLL [FlBL1 [#l5L4
[z BL2 BL2 RLL
w3 BL3 BL3 RL2
— ——
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2. Select the type of compensation you want to perform and the desired
channels, and click OK.

Compensation Setup Guide opens and the Workspace is automatically
populated with the plots necessary to calculate compensation.

Compensation Setup Guide

[ | Load Unstained Control Contro
| lick Run e
Click Record

Position Gate
Stop Fconding wha

@ A o thess con
10000 Evan

D sk shows thia diskeg again Cime
Fs M0

a0l

Freord cxrsirucanky

Cebar Do
Dimplry st lamt 10000~ evenis
<] Recowtr unused sample

122
c=n

Sampie Dinperaed

Eount

Berpukion Volme: I00 L (420 L botal draw veberee)

100 winn

E Note: You can move the Compensation Setup Guide anywhere on the
— Workspace by clicking on its title and dragging it across the Workspace.

E Note: You can remove compensation channels by right clicking on the
—  compensation control under Compensation in the Experiment
Explorer and selecting Delete Control Sample. You can add and
remove compensation controls by opening the Compensation Setup
and selecting/deselecting channels.

3. The Compensation Setup Guide directs you through the steps necessary for
calculating compensation for your samples.

Compensation Setup Guide

Import FCS file Show Compensation Setup

| Load Unstained Control

| ClickRun

Click Record

Paosition Gate

I Do ot shaw this dialeg again | Qs |

4. Install the tube containing the unstained control beads/cells on the sample
injection port as prompted by the software.

5. Push up the tube loader to the active position in the sample injection port and
click Run on the Collection Panel.
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6. Wait until the sample equilibrates, and click Record.

7. Repeat the process for each of the single-stained controls, making sure that the
positive signal for all samples is on scale.

SSC-A (1076)

Scatter BL1
R
80
0
60
50
€
3
40
30
20
0
. M i
0 2 3 4 5 5 7 8 102 100 10t 10° 108
FSC-A (1076) COBFITC - BLI-A

1. To view the Compensation Matrix, select Compensation from the main menu,
then select Compensation Matrix. The Blue/Violet configuration shows VL1,
VL2, VL3, BL1, BL2, and BL3. The Blue/Red configuration shows BL1, BL2,
BL3, BL4, RL1, and RL2.

Compensation Matrix

Compensation Matrix

You can view, manually edit, or reset compensation matrix values here.

=]
BL1 BL2 BL3 Vi1 vi2 Vi3
BL1 [ 10065 | [-0.50 | [-0.57 | [3.08 | [-66.41 | [-6.33 |
BL2 [27.940 | [105.28 | [17.87 | [058 | [-3.78 | [-22s |
BL3 [2.72 | [-28.64 | [104.93 | [0.03 | [0.03 | [3.10 |
Vi1 [0.42 | [0.00 | [0.00 | [100.70 | [-17.0 | [0.01 |
vz [-0.70 | [0.00 | [-001 | [-1025 | [102.24 | [-0.0s |
w3 | 1.56 | [4.08 | [0.10 | [5.02 | [-82.07 | [100.20 |

“ Cance' m

e |

Compensation Matrix

Compensation Matrix

You can view, manually edit, or reset compensation matrix values here,

BL1 BL2 BL3 BL4 RLL RL2
BL1 [ 100.00 | [0.00 | [0.00 | [0.00 | [0.00 | [0.00 |
BL2 | 0.00 | [100.00 | [0.00 | [0.00 | [0.00 | [0.00 |
BL3 [0.00 | [0.00 | [100.00 | [0.00 | [0.00 | [0.00 |
BL4 [ 0.00 | [0.00 | [0.00 | [100.00 | [0.00 | [0.00 |
RL1 [ 0.00 | [0.00 | [0.00 | [0.00 | [100.00 | [0.00 |
RL2 [0.00 | [0.00 | [0.00 | [0.00 | [0.00 | [100.00 |
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@ IMPORTANT! Once you have recorded all compensation controls and
calculated and applied the compensation matrix, you cannot adjust the
PMT voltages for experimental data.

E, Note: The Compensation Matrix is the inverse of the Spillover matrix. To
view the Spillover Matrix, open the FCS viewer and select the Spillover tab.

E, Note: If you need to adjust voltages after recording any of the compensation
controls, you need to remove the data from all compensation controls
containing recorded data by right-clicking on the control sample and
selecting Clear Control Sample Data or right-clicking on Compensation in the
Experiment Explorer and selecting Remove Compensation. If you opt for the
latter, you have to re-run Compensation Setup to recreate all compensation
control samples.
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Generating 1. To generate a Compensation Matrix without control samples, click the Use

Compensation Compensation button.
Matrix without 2. The following dialog box opens:

Control Samples ®  Attune™ Cytometric Software E|

Q This experiment doesn't have a compensation setting.

Do you wish to create a default one or open the compensation setup window?

Create Default Compensation Setup...

Select Create Default to create a blank matrix.

The matrix can now be edited by opening the Compensation Matrix and
entering values in the appropriate fields of the table.

5. Alternatively, you can use the Compensation Slider Bars to adjust the matrix
(See “Applying Compensation” on page 33).
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Generating
Compensation
Matrix Using
Previously
Recorded Data

To generate a Compensation Matrix using previously recorded compensation
controls, select Compensation from the main menu, then select
Compensation Setup Guide and select Import FCS file in the Compensation
Setup Guide window.

Compensation Setup Guide
Show Compensation Setup

Load Unstained Control
Click Run
Click Record

Position Gate

[JDo not show this dialog again | Close

Alternatively, right-click the appropriate compensation control sample and
select Import FCS file.

A m Compensation

7 Delete Control Zample
; Import FCS File...
vz

Set the scatter gate on the desired population and the corresponding
histogram gate on the positive peak.

If no samples have been recorded, the experiment Instrument Settings will
automatically be updated and grayed out to prevent any changes to the
voltages.

If samples have already been recorded and have voltages different from those
used to acquire the compensation controls, the user will be prompted with:

®  Attune™ Cytometric Software &l

WARNING: The voltages in the imported file are different from the experiment voltages. The resulting
compensation may not be appropriate for previously recorded data. Updating the experiment
O voltages is recommended if additional samples are to be acquired.

Do you want to update the experiment voltages with the ones from the imported file?

@ IMPORTANT! We recommend that you import Compensation Settings

prior to recording any sample data so that the voltages used to acquire
samples match those used to acquire the compensation controls. If the
voltages used to generate the Compensation Matrix do not match those
used to acquire a sample, applying compensation may produce
undesirable results.
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Saving the
Compensation
Matrix

Resetting the
Compensation
Matrix

32

1. After creating a Compensation Matrix, you can save it to a desired location by
right clicking on the Compensation option in the Experiment Explorer and
selecting Save Compensation Settings as.

2. To use the saved Compensation Matrix in further experiments, right-click on
the Compensation option in the Experiment Explorer and select Import
Compensation Settings.

To reset the Compensation Matrix to the original calculated values, open the
matrix by clicking Compensation Matrix and then click the Reset button.

If the matrix was created manually, clicking Reset reverts the matrix to the null
(no compensation) matrix.

Attune® Acoustic Focusing Cytometer User Guide



Applying
Compensation

By default compensation is ON when there is a compensation matrix available.

Globally Use Compensation turns compensation ON and OFF for all
plots in the Workspace. When the button is lit, compensation is applied to
all plots. When it is unlit, all plots will show uncompensated data.

Use Compensation turns compensation ON and OFF via a parent plot for
all descendent plots. You must select the parent plot for this button to be
active. If all fluorescent plots are gated from one parent, then this button
acts like the Globally Use Compensation button.

You can view the Compensation Matrix and manually adjust
compensation values by selecting the Compensation Matrix and then
manually entering the values for the parameter of interest. The
Blue/Violet configuration shows VL1, VL2, VL3, BL1, BL2, and BL3. The
Blue/Red configuration shows BL1, BL2, BL3, BL4, RL1, and RL2.

% Compensation Matrix

Compensation Matrix

You can view, manually edit, or reset compensation matrix values here.

arca |
BL1 BL2 BL3 Vi1 vi2 Vi3

BL1 [100.65 | [-0.50 | [-0.57 | [3.08 | [-e6.41 | [6.33 |
BL2 [27.940 | [105.28 | [17.87 | [o.58 | [3.78 | [-225 |
B3 (272 | [-28.64 | [104.93 | [0.03 | [0.03 | [3.10 |
Vi1 [0.12 | [0.00 | [0.00 | [100.70 | [-17.01 | [o.01 |
vz [-070 | [o.00 | [-0.01 | [1025 | [10224 | [-0.05 |
w3 156 | [4.08 | [o.10 | [5.02 | [-80.07 | [100.20 |

—— =

= Compensation Matrix

Compensation Matrix

You can view, manually edit, or reset compensation matrix values here,

=
BL1 BL2 BL3 BL4 RL1 RL2
BL1 [100.00 | [0.00 | [0.00 | [0.00 | [0.00 | [0.00 |
BLz [0.00 | [100.00 | [0.00 | [0.00 | [0.00 | [0.00 |
BL3 [0.00 | [0.00 | [100.00 | [0.00 | [0.00 | [o.00 |
BL4 [0.00 | [0.00 | [0.00 | [100.00 | [0.00 | [o.00 |
RLL [0.00 | [0.00 | [0.00 | [0.00 | [100.00 | [0.00 |
RL2 [0.00 | [0.00 | [0.00 | [0.00 | [0.00 | [100.00 |

T
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¢ You can also use the Compensation Slider Bars to assist in fine-tuning the
Compensation. To use the compensation slider bars, compensation must be
turned on. The slider bars are available during sample acquisition and
recording so the sample can be “tweaked “in real-time.

Lyrsesd Wihoke Bhood

Shder Bars [

e Hovering over the slider bar “handle” will show the compensation value.

¢ To use the compensation sliders, drag the appropriate slider bar to adjust the
population of interest. Only a subset of events is displayed while the slider
bars are used to provide “real-time” movement.

e Adjusting the slider will move populations in the direction the slider bar is
moved on that axis.

e There are two adjustment modes:

o Course Adjustment will move the slider bars in +/- 1 unit increments up 25
units in each direction. To use course adjustment just drag the slider in
either direction.

o Fine Adjustment will move the slider bars in +/- 0.1 unit increments up to
2.5 units in each direction. To use the fine adjustment use “Shift+drag” or
the arrow keys.

¢ Upon release of the mouse, all plots will refresh.

E Note: Adjusting the values in the matrix may adversely affect the
—  compensation in other channels.
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Collect Data

Run Mode

Record Mode

After you have calculated the compensation settings, you are ready to run your
samples to acquire and record data.

The Attune® Cytometric Software has two modes for data collection, the Run
mode and the Record mode.

E Note: If you wish to collect more 500,000 events, you must limit the number
—  of acquisition parameters to 10 or fewer. To select or de-select parameters
for acquisition, open the Instrument Settings from the View tab (see
“Parameters Tab,” page 109). You will be prompted if more than 500,000
events are entered without limiting the parameters to 10 or fewer:

®  Attune™ Cytometric Software

In order to collect greater than 500,000 events, you must have 10 or less parameters selected.
Select OK to continue with the event limit defaulted to 500,000.

T

The Run mode is initiated when Run on the Collection Panel is selected.

In this mode, the software starts data acquisition but no FCS file containing the
data is created.

¢ This mode is primarily used for adjusting the various parameters for
cytometer and experiment optimization and customizing the charts for
recording.

¢ The software actively stores only 20,000 events, and once that limit is reached,
it recycles the events.

e  During the run, the events are displayed on the plots as the graphs are being
populated.

E Note: If compensation is available and turned ON, data will be display
—  compensated during acquisition.

The Record mode is initiated when Record on the Collection Panel is selected.

During recording, the events are displayed on the plots as the graphs are being
populated.

e The software actively displays only 20,000 events during the run. The statistics
window displays only the total events once the recorded run has completed.

\Q Note: To refresh the data displayed on plots, click F5.

¢ In the Record mode, the Attune® Cytometric Software automatically creates an
FCS file when Stop is clicked.

e The software creates a unique name for each FCS file so that an existing file is
not overwritten.
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If the Sample already has an FCS
file, the software displays a
warning that the FCS file is going
to be overwritten. You can choose
to append the existing FCS file or
overwrite it (see “Appending
Data,” page 38).

®  Attune™ Cytometric Software

Specimen unstained cells.fcs has existing data.
How should newly collected data be saved?

e I o o]
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Preparing the
Workspace

Acquiring Data

Recording Data

Prepare your Workspace and customize your plots by selecting each individual
plot one at a time. Change the axis labels and other properties appropriate to your
experiment.

Select the Sample of interest from the Experiment Explorer panel. Double-click
Sample to activate it.

Workspace displays the default sample plots set up for the Experiment. If
desired, you may delete or modify these plots.

Enter the collection criteria in the Collection Panel. You can specify the
collection criteria as “Record continuously” or set limits to collection by the
number of events for specified gates, total sample volume analyzed, or by
elapsed time (see “Collection Panel” on page 97).

Install the tube containing the sample on the sample injection port and lift up
the tube loader to the active position.

Click Run. The events are displayed on the plots as the graphs are being
populated. Wait a short time for the sample to equilibrate.

@ Important! If you are collecting more than 500K events, you should collect

10 or fewer parameters. The progress shown is based on Event Max, which
is 500K for 11 or more parameters and 20M for 10 or fewer parameters.
Unless you set Collection Criteria to “Record continuously,” the progress
bar is displayed during collection.

—_

3.

While still in the Run mode, adjust the PMT voltages and Threshold values for
the appropriate channels using the Instrument Configuration tab (see
“Instrument Configuration” on page 100). Make sure that the events are on
scale.

Click Record to start data collection.

Data is recorded until any of the conditions set in Collection Criteria is
satisfied.

E Note: Click Pause to temporarily halt the data collection.
= You can click Run to resume the data collection from that
point on.

Click Stop to stop the data collection. The Attune® Cytometric
Software automatically saves the data in a unique FCS file.

®

Note: If you set the collection criteria parameter to “Record continuously,”
then the data will be recorded until either the “Acquisition Volume” is
exhausted or the maximum number of events allowed is reached. If you
select more than 10 parameters, the event maximum is 500,000. If you
select 10 or fewer parameters, the event maximum is 20,000,000.
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Appending Data After recording data, you can append the data file with additional data. If you
wish to append a data file for a Sample, you must not modify the Instrument
Settings or collection rate, or change the Sample (e.g., go to the next Sample).
However, you can execute a Rinse function prior to appending data.

To append data:
1. Click Run button, and then click Record.

A dialog box opens and prompts you to select Append, Overwrite, or Cancel.

B Attune™ Cytometric Software

Specimen unstained cells.fcs has existing data.
How should newly collected data be saved?

2. Click Append if you wish to add the new data to the existing FCS.

@ Note: When appending data, the stop criteria is based on the individual
— record cycle and not the total resulting FCS file.

For example, a file containing 10,000 events appended with a run that has
stop criteria of 20,000 events will result in a file with 30,000 total events.
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Warning Messages Various user actions during data acquisition may result in prompts and warning
messages.

e If you lower and raise the tube lifter during a cycle prior to the last sample
draw in a run requiring multiple sample-draws, the following message will
appear:

= Attune™ Cytometric Software

| Please check your sample. Press OK to continue or Cancel and lower the tube lifter to rinse.
.

.

Clicking Cancel initiates the Rinse operation once the tube lifter is lowered.

e If you lower the tube lifter and leave it down during a cycle prior to the last
sample draw in a run requiring multiple sample-draws, the following
message will appear:

= Attune™ Cytometric Software

I Please check your sample. Press OK when sample is loaded and tube lifter is raised, or press Cancel
H to abort the run.

Clicking Cancel aborts the run and automatically initiates Rinse.
e If you lower the tube lifter in the last cycle of a run requiring multiple sample-
draws or during a single cycle run, the following message will appear:
u Status (%)

Ay applied
A b?gsystems

The sample tube was lowered during the run. Lower tube lifter to begin Rinse
operation

« Lower tube lifter

Cancel

If the tube lifter is down, Rinse operation automatically starts.
If the tube lifter is up, lowering the tube lifter initiates the Rinse.

o If the tube lifter is up, Cancel is clicked, and then Run is clicked, the following
message will appear:

= Attune™ Cytometric Software

0 Please pull tube lifter down to initiate a rinse to avoid contamination before collecting again.

To continue, click OK, lower the tube lifter, and allow the Rinse to complete.
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Working with Large Files

Recording Large When recording files with greater than 250,000 events, the Attune® Cytometric
Files Software does not automatically load the entire data set. Instead, only the first
20,000 events of the FCS file are loaded and.:

e The Sample icon in the Experiment Explorer indicates that the Sample 'I:H
contains recorded data.

e The F5icon appears on all plots and statistics boxes indicating that the ®
displayed data is based on 20K total events.

o The statistics text is italicized indicating the values are based on 20K total

events.
Loading Large When opening files with greater than 250,000 events, the Attune® Cytometric
Files Software does not automatically load the entire data set. Instead, only the first
20,000 events of the FCS file are loaded and:
e The Workspace opens with all of the plots and statistics boxes ®
displaying the F5 icon.
o The statistics text is italicized indicating the values are based on 20K total
events.
® @ e [
- - p
S ® - ® :
» i . - ']
pe g = |m
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E Note: When working with large files, it can take a considerable amount of
—  time to load the data into the Workspace. The preview expedites the
process of setting gates, inserting plots, and tweaking compensation.
Calculating statistics is CPU intensive and slows down the refresh rate of
the Workspace.
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Refreshing the Refreshing the Workspace loads the entire data set. You can refresh Workspace
Workspace objects globally all at once or only those plots that require a refresh:

e To refresh the Workspace globally, press the F5 function key or select Refresh
All from the View tab. These actions refresh all Workspace objects.

e Clicking a F5 icon will refresh all plots and statistics that have the F5 ®
icon.

E Note: Whenever you move a gate, create a daughter plot, or perform an
—  operation that affects the relationship between displayed and calculated
data, the F5 icon (®) appears on the object affected by the upstream
change. If compensation is adjusted, all plots will require a refresh.

Workspace before a Refresh

W B —
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Workspace after a Global Refresh
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Workspace requiring a Global Refresh after Compensation Adjustment
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Plots

The Attune® Cytometric Software displays data in histogram, dot, or density plots.

Histogram " sistogram Histogram is a graphical representation of single-
o parameter data and shows the relative number and
L distribution of events. In a histogram, the horizontal axis
i corresponds to the signal intensity of the selected
S parameter while the vertical axis represents the number

of events (count).

10
BL1

A dot plot is a graphical representation of two-
parameter data where each axis represents the signal
intensity of one parameter. Each dot in the plot
corresponds to one or more events detected above the
threshold.

Dot Plot

SSC-A (10°8)
R

A density plot is a graphical representation of two-
parameter data where the colors represent the collection
of events with the same intensity and each axis
represents the signal intensity of one parameter.

Density Plot

SSC-4 (1076)
I

FSC-4 (10°6)

See Customizing Plots on page 115 for more information.
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3. System Maintenance

Maintenance
Schedule

The Attune® Acoustic Focusing Cytometer is designed to require minimum
maintenance. However, to ensure reliability of the cytometer, you must perform
basic preventative maintenance procedures on a regular basis, as listed below.

CAUTION! BIOHAZARD. All biological samples and materials that come
into contact with them have the potential to transmit infectious diseases
and are considered biohazardous. Follow all applicable local,
state/provincial, and/or national regulations. Wear appropriate protective
eyewear, clothing, and gloves. Never pipette by mouth.

The table below lists the routine maintenance procedures that keep the Attune®
Acoustic Focusing Cytometer and all its peripheral systems in good working

condition.

Procedure Frequency
Shutdown Daily
Visual inspection of sample injection Daily

port

Visual inspection of fluidics tanks and | Daily
connections

Visual inspection of syringe pumps Daily
Computer maintenance Monthly
Optical filter cleaning Monthly
Fluidics decontamination Monthly
Changing focusing fluid filter Monthly
Replacing syringes As needed*

*The frequency of maintenance depends on how often you run the cytometer.
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Daily Maintenance

Daily Shutdown Daily shutdown involves executing the Shutdown function. This function ensures
that all sample fluid and dyes have been removed from the fluidics lines and the
two pumps have been decontaminated and filled with Attune® shutdown solution
to prevent the formation salt crystals.

The shutdown procedure takes approximately 30 minutes for the standard 30
rinse cycles, but most of the steps are automated and under computer control. At
the end of the shutdown procedure, the cytometer is automatically powered
down.

Visual Inspection Visually inspect the sample injection port, fluidics tanks and connections, and the
syringe pumps for any leakage. Decontaminate any spills wiping the area with
10% bleach solution.

If you notice any leaks in the fluidics lines, contact your service representative.

Fluidics Daily fluidics cleaning involves executing the De-bubble, Unclog, and Wash

Maintenance functions as needed.

e De-bubble is a user-initiated function for clearing bubbles in the fluidics lines
of the cytometer.

¢ Unclog function is a user-initiated back flush operation to remove clogs from
the sample probe and flow cell.

e Wash is a user-initiated system cleaning between sticky samples. This
function requires user supplied bleach or detergent.
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Monthly Maintenance

Computer Periodically maintaining the computer running the Attune® Cytometric Software
is an important component of a comprehensive maintenance strategy. To preserve
the integrity of your data, observe the following precautions:

Maintenance

e De-fragment the hard drive of the computer monthly.
e Back up your experiments on a regular basis to a secondary storage device.

¢  When planning the experiments, remember to delete parameters that you do
not need (i.e., only collect parameters in either area or height, but not both,
unless you need both parameters for a certain application such as cell cycle).

¢ If an experiment contains several samples, consider collecting some of the
samples under one experiment and then collecting the rest under a second

experiment.
Cleaning Optical The optical filters and mirrors are housed in optical holders, which are located in
Filters and Mirrors the optics compartment. To clean optical filters and lenses, follow the instructions
elow.

CAUTION! LASER HAZARD. Follow the precautions outlined in “Laser
Safety” on page 158 while changing optical filters and mirrors.

The optical filters and mirrors are housed in optical holders, which are located in
the optics compartment. To clean optical filters and lenses:

1. Lift the top cover of the cytometer. The photograph here shows the Blue/Violet
configuration. The location of the optical filters and mirrors are the same in the
Blue/Red configuration.

Optical filters
and mirrors

2. Remove the optical holder containing the appropriate filter or mirror.
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3. Gently remove any dust from the surface of the filter or mirror with a blower
(bulb-blower or compressed gas) or a soft brush.

4. If necessary, gently clean the surface of the filter or mirror using a clean lens
cloth and lens cleaning fluid or methanol.

5. Return the optical holder back to its slot and close the cover of the cytometer.

E Note: The optical holders fit into the slots only one way.

Fluidics To ensure reliability of the instrument, we recommend a monthly decontamination
Decontamination of the fluidics bottles to prevent any bacterial contamination in the bottles.
Contamination symptoms include:

Bacteria growth in the bottle, indicated by cloudy fluid, globs or strings in
the fluid, or discoloration of the fluid.

A very high number of events that do not correspond to the sample (i.e.,
sample dilution has no effect). You can confirm by running Attune®
Performance Tracking Beads and seeing the high event rate (over 1000
events/sec compared to the expected 200-300 events/sec).

To decontaminate the fluidics bottles:

1.
2.
3.

4.

Disconnect all fluidics bottles from the instrument.

Discard all unused fluids.

Pour at least 20 mL deionized water in each bottle, replace cap, and invert
or gently shake to coat all internal surfaces. Discard deionized water.
Pour at least 20 mL 70% isopropanol in each bottle, replace cap, and invert
or gently shake to coat all internal surfaces. Discard isopropanol.

Invert each bottle and allow to air dry.

Place fresh Attune® Focusing Fluid, Attune® Wash Solution, and Attune®
Shutdown Fluid in the corresponding bottle.

Replace all fluidics bottles on the instrument.

Run Startup function.

<\@ Note: All Attune® fluids are packaged under sterile conditions. If a 10X

solution is used, the quality of the deionized water used to dilute the
10X will affect the quality of the final working solution. If
contamination is observed in the 1X fluid, discard fluid immediately
and follow this cleaning procedure.
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Periodic Maintenance

Replacing the Visually inspect the syringe pumps daily for leaks. Replace the syringes if you

Syringes observe leaks from the syringe assembly and/or there is erratic or no fluid draws

up from the fluidics tanks or the sample injection port. To replace the syringes:

1. Execute the Shutdown function with 10% bleach. The plunger drive will be
lowered and the cytometer will power off automatically (see page 13).

2. Open the Syringe Pump door located on the left side of the cytometer (see
“Syringe Pump Compartment” on page 87).

3. Remove the plunger lock screw and unscrew the syringe from the valve by
rotating it counter-clockwise.

4. Toinstall a new syringe, pull the plunger down and align the syringe with the
syringe port of the valve and rotate clockwise until the syringe end cap seal
hits the bottom of the valve. After bottoming out, rotate clockwise %-turn to
ensure complete seal without over-tightening.

@ IMPORTANT! Failure to properly align the syringe when engaging the
valve may lead to cross-threading. No tools should be used for tightening
and securing the syringe to the valve. Over-tightening the syringe beyond
the above recommendation could result in damage to the syringe and the
valve.

5. Align the hole in the plunger with the hole in the plunger holder assembly,
insert the plunger lock screw and tighten.

6. Close the syringe pump door.

E Note: Proper syringe-to-valve seal is crucial for the operation of the
= cytometer, when fluids are cycling through the system. Cavitations may
occur if a seal is not properly attained.
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Appendix A: Ordering Information

The reagents and consumables supplied with the Attune® Acoustic Focusing
Cytometer are also available separately from Life Technologies. Ordering
information is provided below. For more information, go

to www.lifetechnologies.com, or contact Technical Support.

E Note: Refer to the Applied Biosystems® Attune® Auto Sampler User Guide
— (Part no. 4479066) for information about reagents and consumables for the
optional Attune® Auto Sampler,

Product Amount Cat. no.

Attune® Focusing Fluid, 1X Solution 1x1L 4449790
6x1L 4449791

Attune® Focusing Fluid, 10X Solution 1x1L 4449792
Attune® Wash Solution 500 mL 4449755
Attune® 10X Shutdown Solution 250 mL 4454955
Attune® Performance Tracking Beads 50 measurements 4449754
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Appendix B: Performance Tracking

52

Performance Tracking
Baseline Calculations
Performance Test

Reports

<\\;§, Note: Results of instrument performance tracking tests are available for all
users, but only users authorized by the administrator can perform baseline
calculations and performance tests.

Attune® Acoustic Focusing Cytometer User Guide



Performance Tracking

Performance Tracking is a comprehensive set of procedures to monitor the daily
performance of the cytometer. The performance tracking process involves:

¢ Running the same performance tracking bead particle set

¢ Monitoring the changes in the coefficient of variation and the changes in PMT
voltages

e Tracking the linearity of the cytometer
¢ Evaluating the detector quantum efficiency (Q) and optical background (B)

Performance tracking is critical to ensure the accuracy and sensitivity of the
cytometer and it provides information about the lasers and detection channels
available on the Attune® Acoustic Focusing Cytometer.

E Note: For optimal cytometer performance, follow the periodic and
—  scheduled laser and fluidics maintenance procedures (see “System
Maintenance” on page 38).

Performance The Attune® Cytometric Software provides automated Baseline Calculations and
Tracking Functions Performance Test functions with minimal user interaction and facilitates
performance tracking through its Reports feature.

You can access these performance tracking functions from the Main Menu.

£ i 21 ) = e
[
v applied
LobicsyStems
ife technotogi
Perf e Tracking
o Last performance tast completed on Wednasday, December 14, 2011 9:23 A
reomere s
© 05-1720120230PM

New Experiment

( [ | |

- No template No template No template No template
" defined. defined defined defined
g
- Click here to select one. Click here to select one. Click here to select one. Click here to select one.
Il I'l
ke Epeme  Nee N Nee N
No template No template No template No template No template
defined defined defined defined defined
Click here to select one. Click here to select one. Click here to select one. Click here to select one. Click here to select one.
s
nnnnnnnnn
S H|5 | =

E Note: Results of cytometer performance tracking tests are available for all
—  users under the Reports option on the Quality Control menu, but the
Baseline Calculations and Performance Test options are available only to
authorized users.
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Attune® The Attune® Performance Tracking Beads are used to define a baseline for
Performance cytometer performance and conduct daily performance measurements of the
cytometer. They are stained with a combination of fluorophores that can be
excited by the lasers used in the Attune® Acoustic Focusing Cytometers and emit
fluorescence signals at designed levels to all the channels in the cytometer.

Tracking Beads

Each vial of performance tracking beads contains a mixture of four beads at an
equal concentration that differ in relative fluorescence emission intensity: blank,
dim, medium, and bright.

The blank beads in Attune® Performance Tracking Beads have a nominal diameter
of 2.4 pm. The dim, medium, and bright intensity beads have a nominal diameter
of 3.2 um.

@ IMPORTANT! Prepare the Attune® Performance Tracking Bead
suspension immediately before use.

Preparing Attune® 2. Label 12 x 75-mm or 1.5-mL microcentrifuge tubes.

Performance 3. Mix the contents of the bead vial by gentle inversion or gentle vortexing.
Tracking Bead 4. To prepare the tracking bead suspension for Baseline Calculations, add 4 mL
Suspension of Attune® Focusing Fluid or phosphate buffered saline (PBS) and 3 to 4 drops

of Attune® Performance Tracking Beads into the labeled tube.

For daily Performance Test, 1 drop of Attune® Performance Tracking Beads in
1 mL of Attune® Focusing Fluid or PBS is sufficient.

Mix the bead suspension by gentle inversion or vortexing.

Use the beads immediately after mixing, or store the diluted bead suspension
at 2-6°C, protected from light, for no more than 4 hours.

WARNING! Attune® Performance Tracking Beads are non-hazardous
and may be disposed according to local regulations.

Using a New Lot of 1. Before running a new lot of beads, go to www.lifetechnologies.com, navigate
to the Attune® Acoustic Focusing Cytometer’s product page, and import the
lot-specific data file.

The Beadlot data file has *csv format.

2. Save the Beadlot data file in C:\Programs\ Applied
Biosystems\ Attune\ Performance Tracking\Beadlots.
Alternatively, once you have downloaded the beadlot file click Get New Lot #
to navigate to and select the beadlot file. It will automatically populate the
drop-down list and be copied to the Beadlots folder.

Beads
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Baseline Calculations

How It Works

Performing
Baseline
Calculations

The Baseline Calculations workflow of the Attune® Cytometric Software uses
Attune® Performance Tracking Beads to define the cytometer’s initial baseline
status. During this process, the median fluorescence intensity of each bead and
the %HPCV (percent half-peak coefficient of variation) are automatically
measured in all fluorescence detectors. Software algorithms use this information
to determine cytometer settings and provide target values for subsequent
application specific settings.

The software guides you through this process to measure the following values for
each fluorescent bead using assigned MESF (molecule of equivalent soluble
fluorophore) values:

e Relative detector quantum efficiency (rQ)
e Relative background level (rB)

e Linear regression

e Laser delay setting

The Attune® Cytometric Software then automatically adjusts the PMT voltages to
maximize population resolution in each detector, and creates Baseline Calculations
Report (see page 58).

@ IMPORTANT! Make sure to perform baseline calculations after any major
troubleshooting or cytometer service.

1. Log on to the Attune® Cytometric Software.

2. Click Baseline Calculations on the Main Menu.
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3. Prepare Attune® Performance Tracking Bead suspension (see page 54).

Check the beadlot number of the beads you are using. The beadlot number is
the first six digits printed on the label (disregard the alpha numeric
characters).

\\:, Note: Manual Valve must be set to Sip Tube to perform baseline
—  calculations.

5. Select the appropriate beadlot number from the dropdown menu and go to
step 9.

Expiration Date:

.
4449754 Lot 756080

If the lot number of the beads you are using is not available in the dropdown
menu, proceed to step 6.

The expiration date of the beads is displayed in the field above the dropdown
menu and Run Baseline Calculations button becomes active.

Expiration Date: February 11,2013

s s .

Run Baseline Calculations

6. If you are using a new lot of Attune® Performance Tracking Beads, click
Get New Lot #. The Open dialog box appears.

Look in |b Beadlots j £ '
'.2_ 5] 4449754 Lot 756080.csv
My Recent

Documents

Dieskiop

My Documents
My Computer
MYPTI\Ieton‘K File name: | j Spe
laces
Files of type: |Baad\01 Files (".csv) ﬂ %

7. Select the appropriate beadlot file (*.csv) from the Beadlots file folder and
return to step 5.

\\j Note: The Beadlot file folder is located on C:\Programs\ Applied
—  Biosystems\ Attune\Performance Test\Beadlots.
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7. Click Run Baseline Calculations to initiate the automated baseline calculations.
The Workspace displays the acquisition plots and events appear in the plots as
the Attune® Cytometric Software proceeds with baseline calculations.

& ey, et Ciometic Sfvre 21 i) =
o
AR iptied

D biosystems

Scatter Blue Laser

S5C (10%6)

BLIH

) O [Fncion. 7 = 0%
e o 2w

The progress bar provides an ongoing update during the run and the status
display reports the continuing steps of the baseline calculation.

\\J Note: The baseline calculations take approximately 15 minutes to
= complete.

8. At the end of the run, the following message appears on the status display
and the Baseline Calculations Report is displayed.
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Baseline
Calculations
Report

58

BT s

The Baseline Calculations Report screen summarizes the results and compares them
with the target values. It contains the cytometer and user information,
performance tracking beads lot information, detector and laser settings,
specifications, cytometer settings, and results. The sample report below shows the
Blue/Violet configuration with the parameters FSC, SSC, BL1, BL2, BL3, VL1, VL2,

and VL3. The Blue/Red configuration parameters are FSC, SSC, BL1, BL2, BL3,
BL4, RL1, and RL2.

- : i et e 1 EEE
[

v applied

D biosystems Vain Menu
Current Baseline:5/17/2012 3:33 PM - 756080 | BaselineReport
He Page 11 Q@ [d o

Baseline Calculations Report
12/14/2011 9:23 AW - 756080

avomonsa | moneesa | oy | | Qwnnm o
TorgetMFI | ActualMFI  Votage = 202 EMfciend v

Vioet Fsc Tooom|  72s7200 107 | 4s0%

nnnnn

Bue B2 200000 20089300 1075 | 450% o143

Vioet ws 2000000 8578800 1050 | 470% o185 sa5 545 | Cera et

sz

¢ The panel on the left displays the baseline report history. You can access
previous baselines reports through this panel.

Current Baseline: 5/17/2012 3:33 PM - 756080
Lot Mo.: 756080

Expiration Date:05/20/2021
Current Baseline

Baseline 5/17/2012 3:33 PM - 756080

Previous Baselines

Baseline 12/14/2011 9:23 AM - 756080

e The Baseline Calculations Report is saved as a PDF file. You can use the
toolbar above the report to print the report or save it.
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Performance Test

Running
Performance Test

After the baseline values are defined, the same lot of Attune® Performance
Tracking Beads is used to run the Performance Tests to measure variation from
those baseline measurements to track the daily performance of the cytometer.

During this process, the software measures and records the following observables
in all fluorescence detectors:

e Voltage required to place the bright bead in the target channel
e Change in PMT voltage (APMT)
e %HPCV (percent half-peak coefficient of variation) of the bright bead

Using assigned MESF (molecule of equivalent soluble fluorophore) values for each
fluorescent bead, the software calculates the following for each channel:

o Relative detector quantum efficiency (rQ)
¢ Relative background level (rB)

e Linear regression

e Laser delay setting

The results of the performance test can also be viewed as Levey-Jennings charts,
which provide a visual to track the %HPCV and changes in PMT voltage to check
for shifts and trends in cytometer performance.

@ IMPORTANT! We recommend that you run the Performance Test at least
once per day when the cytometer is in use.

1. Turn ON the Attune® Acoustic Focusing Cytometer and the computer (see
page 12).
Log on to the Attune® Cytometric Software.

Click Performance Test on the Main Menu.

Performance Test screen appears.

121

Run Performance Test
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Prepare the Attune® Performance Tracking Bead suspension (see page 54).

5. Check the beadlot number of the beads you are using. The beadlot number is
the first six digits printed on the label.

Make sure that the beadlot number of the performance tracking beads you are
using is identical to the beadlot number used in current baseline.

\\:’ Note: If you are using a new lot of Attune® Performance Tracking
= Beads, download the appropriate lot information (see “Using a New
Lot of Beads” on page 54) and perform new baseline calculations (see
page 55).

6. Click Run Performance Test to initiate the automated ROTTPE oA
Performance Test. '

The Workspace displays the acquisition plots and events appear in the plots as
the Attune® Cytometric Software proceeds with the performance test.

T At Cpometie Sotware 21 i) =leE
[
ARpeted
' biosystems*
Scatter Blue Laser . s BLIH
20 70
G o e L 60 200
15 . 108 4 10 e = %
210 | a0 » * 0 * 3 . W 3 . 8 100 J’\
L 2 12 e 5 "
e 5 50 o / k
0o o o | 0 \J

o o
00 o 15 20 LA R U 1 R T T 00 05 10 15 20 00 05 10 15 20 00
L

10 10*
FSC (10°6) w FSCH (10%) SSCH (10°6) BLIH

nnnnnnnn 0%

The progress bar provides an ongoing update during the run and displays the
steps of the performance test.

Adjusting laser delay on BL1...

\\:’ Note: The performance test takes approximately 15 minutes to
= complete.

At the end of the run, the following message appears on the status display
and Daily Performance Test Report is displayed.
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Daily Performance
Test Report

The result of the daily performance test is displayed at the end of the run.

If the run is successful, the Daily Performance Test Report screen summarizes the
results and compares them with the target values. The sample report below shows
the Blue/Violet configuration with the parameters FSC, SSC, BL1, BL2, BL3, VL1,
VL2, and VL3. The Blue/Red configuration parameters are FSC, SSC, BL1, BL2, BL3,
BL4, RL1, and RL2.

k] R ==k

AAAAAA 5 Cytometic Softuare 21 (Admin)

v& applied
A h‘i)gsystems

Baseline: 5/17/2012 3:33 PM - 756080

17/2012 3:33 PM - 756080
/ Daily 5/17/2012 338 PM
Previous Baselines
Basaline 12/14/2011 9:23 AM - 756080

Performance Report

Viokt ssc o000 7ese2000 075 | 25mv | 0.0% NA NA NA

2600 w5 | w0mv | 100% o2 | staan2

21108100 1125 somv | 080% o 9599 | 1000 CrteraMet

Bue 8L 2000000 195019500 950 somyv | 430% ooy | 125104

Viokt wi o000 21sseez00| s | rsmv | 240% ows | 291374 | 1000 Crterabet

Viokt w2 2000000 taa7as000| 1050 | 25mv | 420% ooz | stat61

el
e The panel on left displays the performance test report history. You can access
previous performance test reports through this panel.
Current Baseline: 5/17/2012 3:33 PM - 756080
Lot No.: 756080
Expiration Date: 05/20/2021

Current Baseline

4 Baseline 5/17/2012 3:33 PM - 756080
v Daily 5/17/2012 3:38 PM

Pravious Baselines

Baseline 12/14/2011 9:23 AM - 756080

#  This symbol indicates that the daily performance was successful. The
performance test results are shown as “Criteria Met” along with the date
and time of the run.

This symbol indicates that one or more parameters deviated slightly from
the baseline values. The performance test results are shown as borderline
along with the date and time of the run.

This symbol indicates that the results of the performance test deviate
significantly from the baseline values. The performance test results are
shown as “Out of Range” along with the date and time of the run.

e The Performance Test Report is saved as a PDF file. You can use the toolbar
above the report to print the report or save it on a location of your choice (e.g.,
flash drive).

= =

X

[1 71 & ® [100% - g colborate ~ A s = [ -
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Levey-Jennings
Report

62

The results of the performance test can also be viewed as Levey-Jennings charts,
which provide a visual indication of the performance of the cytometer over time.

To review the Levey-Jennings Report, click Levey-Jennings Report tab on the
upper-left corner of the Performance Test screen.

Performance Test Report Levey-Jennings Report

A3

Pefformance Report _ ‘

The Levey-Jennings Report tracks the %HPCV and changes in PMT voltages for
all channels to check for shifts and trends in cytometer performance.

= =s

Levey-Jennings Report

Baseline 12/14/2011 9:23 AM - 756080

FSC Delta PMT Voltage FSC Bright Bead %HPCV

SSC Delta PMIT Voltage SSC Bright Bead %HPCV

@ CrieriaNet @ Borderine @ OutOfRange o Dafa

@O | funcions 4

;e e ]

o Criteria Met: If the daily performance of the particular detector is within the
limits set by the baseline calculation, it is plotted as a solid green circle in the
Levey-Jennings chart.

¢ Borderline: If the daily performance of the particular detector deviates
slightly from the baseline, it is plotted as a solid yellow circle in the
Levey-Jennings chart.

¢ Out of Range: If the daily performance of the particular detector deviates
significantly from the baseline, it is plotted as a solid red circle in the
Levey-Jennings chart.

¢ No Data: If the daily performance test is unable to find a PMT or %HPCV it
will be indicated in the Levey-Jennings chart with a solid white circle.

The Levey-Jennings Report is saved as a PDF file. You can use the toolbar above
the report to print the report or save it on a location of your choice.

= B O [T 71 1k &Y @& | ® @ [ - g colborate = sn - | = [ -
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Reports

You can access the archived results of the Baseline Calculations and Performance
Tests to determine the daily performance of the Attune® Acoustic Focusing
Cytometer and monitor changes in its accuracy and sensitivity using the Reports
function, which is available through the Main Menu.

The performance tracking reports include a summary of baseline calculations,
review of the linearity of PMTs, laser performance tracking and alignment, as well
as Levey-Jennings plots that chart historical performance testing data. See

pages 64-65 for examples of Performance and Levey-Jennings Reports.

\@ Note: By default, the performance tracking reports are saved in
—  C:\Program Files\ Applied Biosystems\ Attune\Performance Tracking
unless changed by the Administrator (see “Software Administration” on
page 133).

- = ione® CameseSofvare 21 (i) =TEEs

al

ABapplied

X bfzystems
by Life technologies

Performance Tracking
Browse Experiments

o/ Last performance tast completed on Wednesday, December 14, 2011 3:23 AM

Performance Test Reports

© 2272010553 A0
3 122720110553 AMU).
© 0572012023081

New Experiment

No template No template No template No template
defined. defined defined defined
Click here to select one. Click here to select one. Click here to select one. Click here to select one.
SlankTube Expeiment Stanc e Ecpeiment Nore. None N e
No template No template No template No template No template
defined defined defined defined defined

Click here to select one. Click here to select one. Click here to select one. Click here to select one. Click here to select one.

nnnnnnnnn

E Note: Results of instrument performance tracking tests are available for all

—  users under the Reports option on the Performance Tracking menu, but the
Baseline Calculations and Performance Test functions can only be
performed by authorized users.
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Attune® The sample report below shows the Blue/Violet configuration with the
Performance parameters FSC, SSC, BL1, BL2, BL3, VL1, VL2, and VL3. The Blue/Red
Report Example configuration parameters are FSC, SSC, BL1, BL2, BL3, BL4, RL1, and RL2.

Performance Report

Instrument Name: Your Instrument Name Operator: Administrator
Serial Number: Your Instrument Serial Number Run Date: 11/15/2010 3:41:56PM
Institution: Your Institution Name Product Name: 4 Peak Beads
Software Version: 12 Lot Number: 756080
Laser Delay: 312 Expiration Date: 02/11/2013

Detector Settings

. paramoter | BrightBead | BrightBead | pmT | DeltaPMT Daht :fr"“f"“'“ gl o
TargetMFI | Actual MFI | Voltage |  Voltage ) jeiancy, (B8) lh20d. Seult
%HPCV (@)
Violet Fsc 700000  695713.56 2825 75mv | 239% NA NA NA | Criteria Met
Violet 8sC 700000 729889.94 2650 50 mv 599% N/A N/A N/A | Cnteria Met
Blue BL1 2000000 194152425 2375 25mv | 152% 0.07 578,839 1.000 | Criteria Met
Blue BL2 2000000 202148575 2350 omv | 124% 0239 267 647 1.000 | Criteria Met
Blue BL3 2000000 205982550 2450 Bmv | 159% 0185 281,062 1.000 | Criteria Met
Violet v 2000000 205161525 1350 25my | 138% 0051 | 30453 1.000 | Criteria Met
Violet vi2 2000000 207873363 2375 somv | 154% 0015 | 4440303 1.000 | Criteria Met
Violet Vi3 2000000 205590200 1950 somv | 147% 0.163 354 965 996 | Criteria Met
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Levey-Jennings
Report Example

The sample report below shows the Blue/Violet configuration with the Delta PMT
Voltage and Bright Bead %HPCV values for FSC, SSC, BL1, BL2, BL3, VL1, VL2,
and VL3. The report for the Blue/Red configuration shows the Delta PMT and
Bright Bead %HPCV values for FSC, SSC, BL1, BL2, BL3, BL4, RL1, and RL2.

Levey-Jennings Report

Instrument Name:  Your Instrument Name Operator:  Administrator
Serial Number:  Your Instrument Serial Number Run Date: 11/15/2010 3:41 PM
Institution:  Your Instituion Name Product Name: 4 Peak Beads
Software Version: 1.2.0 Lot Number: 756080
Expiration Date: 2/11/2013
FSC Delta PMT Voltage FSC Bright Bead % HPCV
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Levey-Jennings
Report Example,
continued
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Appendix C: Instrument Description

System Components

The Applied Biosystems® Attune® Acoustic Focusing Cytometer is shipped with
the system components listed below. All components are shipped at ambient
temperature.

Component Quantity

Applied Biosystems® Attune® Acoustic Focusing Cytometer 1
Either:

Blue/Violet configuration
Blue/Red configuration

Power cord kit, universal voltage C13 2.5 m RC
Cable, USB 2.0 A-BM/M, 6 ft RC
Cable, network RJ45 M /M CAT6 STP, 7 ft BLUE RC

24-inch monitor

Dell® computer (including mouse, keyboard, and mouse pad)

Applied Biosystems® Attune® Cytometric Software (CD)

Attune® Performance Tracking Beads, 3 mL
Attune® Wash Solution, 500 mL
Attune® Focusing Fluid, 6 x 1L

Attune® 10X Shutdown Solution, 250 mL

Applied Biosystems® Attune® Acoustic Focusing Cytometer Quick
Reference Card

Applied Biosystems® Attune® Acoustic Focusing Cytometer User Guide 1

| |IN|Rr|R|R|[RPR|[PR|[R|[~=L]W

Intended Use For Research Use Only. Not for use in diagnostic procedures.
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System Specifications

Physical
Characteristics

Optics

Fluidics

Electronics

Computer

User Interaction
with Instrument

Attune®
Cytometric
Software

Footprint (H x W x D): Approximately 16”7 /40 cm x 23”7 /58 cm x 17”7 /43 cm
Weight: Approximately 64 1b/29 kg

Operating temperature: 15-30°C

Operating humidity: <80% non-condensing

Electrical requirements: 100-240VAC, 50/60 Hz, <300 W

Excitation lasers: Blue/Violet configuration uses a 488nm, 20mW laser and a 405nm,

50mW laser, and the Blue/Red configuration uses a 488nm, 20mW laser and a
638nm, 50mW laser.
Alignment: Fixed alignment, no customer maintenance required

Sample input rates: ~1 sample/minute

Sample rates: 25-1,000 pL/minute

Cuvette flow velocity: 0.5 m/second or 2.0 m/second

Sample delivery: Calibrated delivery volumes for volumetric analysis
Sample analysis volume: 50 uL—4 mL

Minimum required sample volume: 120 pL

Fluid storage: Within instrument with level sensing

Nominal fluid consumption: 1 L/day

Sample tubes: Accommodates from 17 x 100 mm to 8.5 x 45 mm tubes

Particle size range: 1.0 ym to 45 uym

‘{ Note: The minimum sample analysis volume is 50 uL. However, the
] system requires that at least 220 uL is used to account for the analysis

volume + boost volume + safety volume.

Data acquisition: Up to 20,000 events/second
Resolution: At least 6 decades
PMT voltage: User-adjustable

e Minitower running Windows® XP SP3
e  24-inch flat panel monitor

e Visual display of system status on instrument

e Instrument startup < 15 minutes and automated shutdown
e User-changeable, keyed filters

e Fully automated and manual compensation modes

e Audible noise <50 dBA at 0.5 m

e Software allows data acquisition and analysis (width, height, and area
measurements) and controls the instrument

¢ Output file format FCS 3.0
¢ Live gating with automatic saving
e Operator and administrator log in

Attune® Acoustic Focusing Cytometer User Guide
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Operation Principles and Technical Overview

Sample Loading

Acoustic Focusing

Sample
Interrogation

70

The Attune® Acoustic Focusing Cytometer is a benchtop cytometer that uses
acoustic pressure to confine the injected particles to a tight central line along the
axis of the capillary as the sample passes through the optical cell for interrogation.

& applied
ABbli)gsystems

This section explains how the Attune® Acoustic Focusing Cytometer measures
scattered light and fluorescence as cells pass through the laser beam.

The sample is loaded into the Attune® Acoustic Focusing Cytometer via the sample
injection tube, which automatically delivers the sample to the flow cell after the tube
lifter is engaged and the user defines collection criteria. The sample and the focusing
fluid are pushed through a capillary assembly where it is intercepted by the laser
beam for interrogation. The capillary assembly is an acoustic resonant device that
focuses cells or particles into a single, tight line using a capillary coupled to a single
piezoelectric transducer.

Acoustic focusing exploits the size, density, and compressibility differences between
cells or particles relative to the background carrier medium to position the particles
or cells into a single, focused line along the central axis of a flow channel. Because
acoustic focusing is independent of sample fluid flow, the Attune® Acoustic
Focusing Cytometer allows a tight control over the sample flow rate, which in turn
permits the control of interrogation time, enabling higher sensitivity and precision.

As the sample traverses the interrogation point, the Attune® Acoustic Focusing
Cytometer uses a violet and a blue laser or a red and a blue laser to illuminate the
particles or cells in the sample, which scatter the laser light and emit fluorescent
light from fluorescent dyes attached to them. The optical filters and mirrors route
specified wavelengths of the resulting light scatter and fluorescence signals to the
designated optical detectors.
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Signal Processing The Attune® Acoustic Focusing Cytometer has seven PMT detectors and one Diode
detector (FSC) for converting the fluorescence signals and collected light scatter into
electrical signals (i.e., voltage pulses), which are proportional to the intensity of the
light received by the detectors. Six PMTs are dedicated to fluorescence detection,
one PMT detects signals from SSC, and FSC is obtained from a diode detector. The
digital electronics of the cytometer amplify and analyze these pulses, and transfer
them to the workstation computer for further processing by the Attune® Cytometric
Software.

Results Results are saved as FCS 3.0 files in the appropriate user folders.
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Fluidics

The fluidics system of the Attune® Acoustic Focusing Cytometer establishes the
fluid flows required for acoustic focusing cytometer operation. This includes the
flows during the main data collection operation as well as during the Startup,
Wash, Unclog, Rinse, Run, De-bubble, Stop, and Shutdown operations.

The sample to be analyzed is driven by a syringe pump and passes through the
bubble sensor and the sample loop before arriving at the capillary assembly. A
separate pump forces the focusing fluid through the focusing fluid filter and flow
dampener.

The capillary assembly is an acoustic resonant device that focuses cells or particles
in the sample fluid into a single tight line (i.e., the sample core) using a capillary
coupled to a single piezoelectric transducer. The capillary carries the sample core
upward through the center of the optical cell, where the particles to be analyzed
are intercepted by a tightly-focused laser beam for interrogation.

After passing through the optical cell, the stream arrives at the waste container.

Schematics of the
Fluidics System

Waste

A

72

Laser
Intercept
Points
Flow Cell
S |
: Capillary
: Assembly
i Focusing Fluid
Reservoir i i| Sample Loop
Movement Focusing Fluid Movement
via i | Filter Bubble Sensor | : via
Focusing Pump | { Sample Pump
Focusing Fluid Sample Tube
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Acoustic Focusing

Flow Rate

The objective in flow cytometry is to measure the properties of individual particles
as they move through the laser beam. When a sample in solution is injected into a
flow cytometer, the cells or particles are randomly distributed in three-
dimensional space and must be ordered into a stream of single particles.

Acoustic focusing exploits the physical differences between cells or particles
relative to the background carrier medium to position the particles or cells into a
single, focused line along the central axis of a flow channel independent of sample
fluid flow. In contrast to a conventional hydrodynamic sheath-focused cytometer,
the Attune® Acoustic Focusing Cytometer gives users tight control over the
sample flow rate, which in turn permits the control of interrogation time, enabling
higher sensitivity and precision.

The images below show the alignment and concentration effects of acoustic
focusing on a whole-blood sample.

Acoustic focusing off Acoustic focusing on Acoustic focusing on
(dilute sample)

In a conventional cytometer, the diameter of the sample core is varied by the
pressure difference between the sample stream and the sheath fluid stream.
Increasing the sample flow rate enlarges the core diameter, which allows faster
data acquisition but lower resolution because the cells can float freely in the
sample core stream and may pass through the laser spot off center.

In contrast, the alignment of cells in the Attune® Acoustic Focusing Cytometer is
independent of the total fluid flow through the cytometer. While large changes in
the amount of sample injected or the total fluid flow may alter the diameter of the
sample core, this does not affect the resolution of the cytometer because constant
focusing ensures that the cells remain in the optimal position for interrogation by
the aligned laser. This feature of the cytometer allows even dilute samples to be
analyzed at a high rate without a loss of resolution. The Attune® Acoustic
Focusing Cytometer has a maximum flow rate of 1 mL/minute, but we
recommend that you run your samples at a collection rate of 25-500 uL/minute
for the best results.
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Sample
Concentration

Effects of Acoustic
Focusing on Cell
Viability
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If high sensitivity is more important than throughput, the flow rate can be
decreased four-fold by switching the cytometer to high-sensitivity mode to
maximize the collection of fluorescence photons, which are dependent upon the
excitation intensity and cell transit time.

All cytometers are governed by Poisson statistics, which predict the probability of
a given number of cells or particles being intercepted by the interrogating laser
beam. While increasing the sample concentration results in a higher sample
throughput, it also increases the probability of a coincident event, defined as more
than one cell present in the interrogating laser beam.

The Attune® Acoustic Focusing Cytometer can maintain its maximum particle
analysis rate over a large range of initial sample concentrations without the need
to concentrate using centrifugation or filtration. The ability to analyze dilute
samples has the added benefits of reduced background fluorescence from free
fluorophores in the sample and capability to analyze very small initial samples
sizes.

Acoustic focusing differs fundamentally from ultrasonic lysis of cells and is
generally gentler on cells than the forces occurring in hydrodynamic focusing.

Ultrasonic lysis of cells relies on cavitation produced at sub-megahertz frequencies
where tiny gas bubbles form and collapse with immense local shear and heating in
the solution containing the sample. In contrast, the acoustic focusing capillary of
the Attune® Acoustic Focusing Cytometer operates at a frequency well above

1 MHz, where the possibility of cavitation is greatly reduced. Further, acoustic
cytometry is performed with relatively low energy levels at very high sample flow
rates and the design of the acoustically-driven capillary spreads this energy over
the entire length of the capillary, significantly reducing the probability of cellular
damage.
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Optics

Light Scatter

Measuring Light
Scatter

Fluorescence

When a cell or particle passes through a focused laser beam, it refracts or scatters
light in all directions.

o Forward scatter, or low-angle light scatter, is the light that is scattered in the
forward direction as laser light strikes the cell. The magnitude of forward
scatter is roughly proportional to the size of the cell or particle, and this data
can be used to quantify particle size.

e Side scatter is defined as the light that is scattered at larger angles. Side scatter
is indicative of the granularity and structural complexity inside the cell or
particle.

Forward scatter

l

Side scatter

Forward-scattered light is quantified by a detector that converts intensity into
voltage. In most cytometers, a blocking bar (called an obscuration bar) is placed in
front of the forward scatter detector. The obscuration bar prevents intense laser
light from reaching the detector. As a cell crosses the laser, light is scattered
around the obscuration bar and is collected by the detector.

Side-scattered light is focused through a lens system and is collected by a separate
detector, usually located 90° from the laser’s path.

Fluorescence is the emission of light that occurs when an emitting particle such as
a fluorophore-labeled antibody absorbs light from another source such as the
intercepting laser beam. When the particle absorbs the intercepting light, it is
elevated to an excited electronic state, and as it returns to its ground state, the
absorbed energy is radiated where most of it is emitted as light. The emitted light
is always a longer wavelength (i.e., less energetic) than the absorbed light. The
difference between the excitation and emission wavelengths is known as the
Stokes shift.

Flow cytometry uses fluorescence detectors to identify different aspects of cells
including functional assays and subset identification. One of the most common
ways to study cellular characteristics using flow cytometry involves the use of
fluorescent molecules such as fluorophore-labeled antibodies. In these
experiments, a fluorescently-labeled antibody is added to the cell sample. The
antibody then binds to a specific molecule on the cell surface or inside the cell.
When laser light of the right wavelength strikes the fluorophore, a fluorescent
signal is emitted and detected by the flow cytometer, indicating a specific
binding event.

Fluorescence data is collected in generally the same way as side scatter data. In a
population of labeled cells, some will be brighter than others. As each cell crosses
the path of the laser, a fluorescence signal is generated. The fluorescent light is
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then directed to the appropriate detector where it is translated into a voltage pulse
proportional to the amount of fluorescence emitted. All of the voltage pulses are
recorded and can be presented graphically. Multiple colors can be used on a flow
cytometer and the number of colors that can be detected depends upon the
number of detectors available in the cytometer. The different colors are collected
using select optical filters that direct the light to the right detector and capture the
peak fluorescent signals.

Optical Filters Optical Filters separate the light scatter and fluorescence directed to detectors by
wavelength, which is measured in nanometers (nm). They selectively transmit
light having a particular range of wavelengths, while absorbing or reflecting
the remainder.

photons
reflected

photons
absorbed

Fansmited
There are five types of optical filters used in flow cytometry:

e Bandpass filter (BP)

e Longpass filter (LP)

e Shortpass filter (SP)

e Dichroic mirror (DM)

¢ Neutral density filter (ND)
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Bandpass Filter

Bandpass Filter (BP) is a device that passes wavelengths within a certain range and
attenuates (i.e., rejects) wavelengths outside that range. Combining an LP filter
and an SP filter produces a bandpass (BP) filter. These filters usually have lower
transmittance values than SP and LP filters, and block all wavelengths outside the
selected interval, which can be wide or narrow depending on the number of layers
of the filter.

The bandwidth of the filter is simply the difference between the upper- and
lower-cutoff wavelengths. Common bandpass filter nomenclature is the peak
emission/bandwidth.

For example, a filter that would detect Alexa Fluor® 488 dye would be 530/30,
which would allow wavelengths in the 515-545 nm range to pass.

4880M  Bp 530130

460 nm

520 nm I
540 nm

700 nm

Alexa Fluor® 488
emission spectrum

BP 530/30 500 nm 600 nm
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Longpass Filter

78

Longpass filter (LP) is an optical interference or colored glass filter that attenuates
shorter wavelengths and transmits (i.e., passes) longer wavelengths over the
active range of the target spectrum (ultraviolet, visible, or infrared). Longpass
filters, which can have a very sharp slope (referred to as edge filters), are
described by the cut-on wavelength at 50% of peak transmission.

For example, an LP 530 filter permits wavelengths longer than 530 nm to pass,
while reflecting or absorbing wavelengths shorter than 530 nm.

700 nm I
540 nm \
460 nm

LP 530

488 nm
v LP 530

Alexa Fluor® 488
emission spectrum

520 nm 560 nm 600 nm
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Shortpass Filter

Dichroic Mirror

Neutral Density
Filter

Shortpass filter (SP) is an optical interference or colored glass filter that attenuates
longer wavelengths and transmits shorter wavelengths over the active range of
the target spectrum (usually the ultraviolet and visible region).

For example, an SP 530 filter permits wavelengths shorter than 530 nm to pass,
while reflecting or absorbing wavelengths longer than 530 nm.

460 nm

540 nm

SP 530

Dichroic mirrors, also called "reflective,” "thin film," or "interference" filters, are
produced by coating a glass substrate with a series of optical coatings. Dichroic
filters usually reflect the unwanted portion of the light and transmit the
remainder.

A dichroic filter is a very accurate color filter used to selectively pass light of a
small range of colors while reflecting other colors. By comparison, dichroic
mirrors and dichroic reflectors tend to be characterized by the color(s) of light that
they reflect, rather than the color(s) they pass.

Dichroic mirrors are essential to the optical path of a flow cytometer because they
direct the emission light to the appropriate photomultiplier tube detector.

540 nm
460 nm

LP 530

Neutral density filters (ND) have constant attenuation across the range of visible
wavelengths, and are used to reduce the intensity of light by reflecting or
absorbing a portion of it.
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Compensation

80

Fluorophores emit light over a range of wavelengths. Although optical filters limit the
range of frequencies measured by a given detector, when two or more fluorophores
are used in an experiment, there is often an overlap between the wavelength ranges.
Compensation is the mathematical method used to correct for the overlap of one
fluorophore’s emission into another fluorophore’s emission measurements.

Every fluorescent molecule emits light with a particular spectrum unique to that
molecule. These emission spectra overlap, in some cases very significantly. The
example below shows the emission spectra of Pacific Blue™, Alexa Fluor® 488,
R-phycoerythrin (R-PE), and Alexa Fluor® 647-R-PE dyes.

488 nm

450/40 v 530/30 575/24 640 LP
/-\\ / \ /'\ f'\ B Alexa Fluor® 488
R [ 1A ) \

- NEm | EmEa \ - e

l‘ ‘\ f \ ’ \ \ B Pacific Blue™
/ \\{[ \\ II \\ \\ B Alexa Fluor® 647-R-PE
/ J N~ | X
/ A [ =
LV e T e — ==

440 nm 480 nm 530 nm 560 nm 600 nm 640 nm 680 nm 720 nm

Each dye emits with a characteristic emission spectrum that is specific for the
fluorophore: Alexa Fluor® 488 dye has a maximum around 520 nm, R-PE at about
575 nm, Pacific Blue™ dye at about 454 nm, and Alexa Fluor® 647-R-PE dye at about
666 nm. The teal line represents the laser excitation wavelength of an argon ion laser
(488 nm).

In this example, the emission spectra of each dye is backlit with a shaded area
indicating the emission filter where the specific light is captured on the Attune®
Acoustic Cytometer. In general, filters are chosen which collect the emitted light near
the emission maximum. For example, to capture the emission from Alexa Fluor® 488
dye, a BP 530/30 filter is used (i.e., the filter has a pass-band centered at 530 nm, and
the width of the pass-band is 30 nm).

However, it is impossible to choose filters which measure only one dye. For instance,
the Alexa Fluor® 488 dye has a significant emission in the region that

RP-E is measured (575 nm). Therefore, the emission from Alexa Fluor® 488 dye will
register in 530 nm and 575 nm bands. If R-PE is also present, it will contribute to the
575 nm band. Compensation is the mathematical process for correcting for the amount
of the Alexa Fluor® 488 dye fluorescence in the 575 nm band so that R-PE fluorescence
can be accurately measured. Performing multicolor analyses can complicate this
process further, because fluorophores are not usually spectrally separated very well.

Fluorescence spill over can be estimated by running single fluorescence controls
specific for a certain dye and then subtracting out the fluorescence in the other
detection channels, thus leaving the true signal of the other fluorophores. If a
fluorescent dye emission is collected through three different filters, then the amount of
fluorescence captured through the first filter can be estimated based on how much
spillover or contaminating signal is present in the second or the third filters. In the
example above, the Pacific Blue™ conjugate has some fluorescence in the 530/30 filter
and very little in the 575/24 filter; therefore, the amount of compensation required in
the 530/30 filter will be more than in the 575/24 filter.
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Electronics

Voltage Pulse

When a cell or particle passes through a focused laser beam, it refracts or scatters
light in all directions and can emit fluorescence. The scatter and the fluorescence
last only a few microseconds, because the cells or particles are moving very
rapidly through the focused laser beam. The detectors convert the momentary
flash of light into an electrical signal called a voltage pulse.

When the cell or particle begins to enter the intercepting laser beam, the signal
intensity is low, because only a small portion of the particle scatters the light.

The pulse reaches its maximum when the cell or particle is in the middle of the
laser beam, and the whole particle scatters the light. Further, the laser beam is
brightest in the middle, thus causing more light to scatter off of the particle.

As the cell or particle exits the beam, the signal starts decreasing and eventually
trails off below the threshold.

Laser beam ‘ ‘

Particle or cell O

Sample
flow

Voltage

Time

Voltage

Time

Voltage

Time

—
—i
—4

Voltage

Time
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Pulse
Measurement

82

The analog signal from the detectors are amplified and relayed to the 24-bit
analog-to-digital converter (ADC), which samples the signals at a rate of up to
2.5 MHz, converting the continuous signal into digital data and producing

6 decades resolution for up to 20,000 events per second.

The data is further processed by the field programmable gate array (FPGA), which
simultaneously calculates pulse height, area, and width when the pulse exceeds
the user-specified threshold value.

width

= Pulse area
<) =)
> £
= [0}
g % trigger

& threshold

/
front (rear - front)
extension extension

Time
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Optical Layout

Instrument Default Filter
. ; . Fluorophores Other fluorescent reagents
Configuration | filter (nm) | range (nm)
PO-PRO™-1
DyeCycle™ Violet
© Fixable Violet Dead Cell Stain
g 2 Pacific Blue™ CellTrace™ Violet
=] = -
@ E 450/40 430-470 Alexa Fluor® 405 Calcein Violet
@ SYTOX® Blue
_ FxCycle™ Violet
E Click-iT® Pacific Blue™
[Fe)
3 ko)
— c ° . .
o o = _ Qdot® 525 Fixable Aqua Dead Cell Stain
s s 3 522/31 507-537 Horizon™ V500 F2N125 (apoptotic)
@
© 3
o o i . .
= Pacific Orange™ Fixable Yellow Dead Cell Stain
c > -
i 2 603/48 o79-621 Qdot® 605 F2N12S (live)
@
Calcein
Fluo-3/Fluo-4
TO-PRO®-1 iodide
g CFSE
3| = GFP
c| o 5 Alexa Fluor® 488 JC-1/Di0C2(3)
E _E g % 530/30 515-545 Fluorescein SYTOX® Green
= o 38 DyeCycle™ Green
s g Z Rhodamine 123
I S YO-PRO®-1 iodide
g g Fixable Green Dead Cell Stain
w g Click-iT® ALexa Fluor® 488
- " PI
S Fura Red™ AM cell permeant
® *E DyeCycle™ Orange
_ 2 El JC-1/Di0C2(3)
c -
E i “? 574126 561-587 PE pHrodo™ Phagocytosis Particale Labeling
o S ;
2 3 Kit
= = SNARF® (low pH)
g SYTOX® Orange Dead cell stain
@ PE-Alexa Fluor® 610
PerCP
PE-Alexa Fluor® 700 JC-1/Dioc2(3)
3] PE-Cy® 5.5 Fixable Red Dead Cell Stain
° TRI-COLOR® antibody 7-AAD
> ) -
E 640LP >640 PerP(;Ii‘CC)é@®75.5 SNARF® (high pH) isomers
o y SYTOX® AADvanced™ Dead Cell Stain
° PE-Alexa Fluor® 750 DveCvele™ Rub
& Qdot® 655 yeLy y
Qdot® 705
Qdot® 800
- Qdot® 705
2 PerCP®
T 690/50 665-715 |TRI-COLOR® (TC, PE-Cy®5) Vybrant® Dye Cycle™ Ruby
2 PerCP®-Cy5.5
PE-Cy®5.5
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Instrument Default Filter
. . . Fluorophores Other fluorescent reagents
Configuration | filter [hm) | range [nm)
o
2 PE-Alexa Fluor® 750
3 780/60 750-810 Qdot® 800 Vybrant® Dye Cycle™ Ruby
2 PE-Cy®7
- Fixable Far Red Dead Cell Stain
° 5} Click-iT® Alexa Fluor® 647
[4] o .
& ° 660/20 650-670 Alf&iﬁfli;‘g éﬁs ¢l FxCycle™ Far Red
E L 2 SYTOX® Red Dead cell stain
o TO-PRO-3
(32}
ot
° o
x -
& . é APC-Alexa Fluor® 750 Fixable Near-IR Dead Cell Stain
3 5 780/60 730-810 APC-Cy®7 Vybrant® Dye Cycle™ Ruby
z Z APC-H7

84
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Overall Geometry
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Notes 1. At Side Scatter location, the neutral density (ND) filter is in a user-removable

filter holder and the 405/10 filter is in a non-user-removable filter holder tube.
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Instrument Exterior Components

Power Status Indicator
Switch Lights

Sample

Fluidics Injection
Compartment Port

Sample Injection
Port (SIP)

Sample
Injection
Tube

Sample
Tube Lifter
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Instrument Interior Components

Fluidics The images below show the fluidics compartment of the Attune® Acoustic Focusing
Cytometer.

Compartment

Fluid Lines

| Fill Sensor Connections

Focusing Fluid Shutdown Fluid
Compartment Compartment )
) Waste Focusing Wash  Shutdown
Waste Container Wash Fluid Fluid Fluid Fluid
Compartment Compartment
Syringe Pump The image below shows the syringe pump compartment of the Attune® Acoustic
Compartment Focusing Cytometer.

Syringe
pumps

Focusing
fluid filter
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Optics The image below shows the optics compartment of the Attune® Acoustic Focusing
Cytometer. This image shows the Blue/Violet configuration. The location of the

Compartment . ' . ¢
components is the same in the Blue/Red configuration.

Beam shaping

optics
Storage for spare Collection Collection Recessed PMTs
collection optics optics lens and amplifiers
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Status Indicator Lights

The Status Indicator Lights above the sample injection port identify the status of the

cytometer.
Error Clog
Startup/ Alarm Wash Trigger
Ready Processing/
Running
] 4] = ®

Instrument Cycle Green Red Blue Yellow Green
Startup BLINK ON/OFF* ON OFF OFF

*Indicator light is ON for 10 seconds, and then turns off.

Startup complete ON OFF OFF OFF OFF
Idle ON OFF OFF OFF OFF
Run ON OFF OFF OFF BLINK*

*Indicator light blinks with cycle time proportional to event rate.

Run complete ON OFF OFF OFF OFF

Wash/Declog/De-bubble OFF OFF BLINK OFF OFF

Rinse OFF BLINK/OFF* ON OFF OFF
*Indicator light blinks when the rinse cycle is initiated and turns off when it
is okay to place the sample on the sample injection port.

Clog detected OFF BLINK OFF ON OFF

Focusing fluid tank empty

Waste tank full

Wash tank empty OFF BLINK OFF OFF OFF

Water tank empty

Shutdown OFF OFF BLINK OFF OFF

Error OFF ON OFF OFF OFF
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Instrument Reagents and Consumables

Attune® Focusing
Fluid

Attune® Wash
Solution

Attune® Shutdown
Solution

Attune®
Performance
Tracking Beads
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The following reagents are approved for use on this system.

@ IMPORTANT! Reagents may be stored at colder temperatures, but
running the cytometer with cold reagents (<15°C) will affect the data
quality. Before you run the cytometer, ensure that all reagent temperatures
are at least 15°C.

The Attune®Focusing Fluid is a buffered, azide-free support/carrier reagent for
transporting the samples through the Attune® Acoustic Focusing Cytometer. It
contains a surfactant and a preservative.

For best results, store the Attune® Focusing Fluid at 15-30°C.

The Attune® Wash Solution is a ready-to-use solution that has been formulated to
remove cellular debris and dyes from the fluidics system of the Attune® Acoustic
Focusing Cytometer.

Store the Attune® Wash Solution at 15-30°C. The wash solution is stable on the
cytometer for 30 days after the bottle has been opened.

The Attune® Shutdown Solution is a 10X solution that prevents the formation of
air bubbles and salt deposits in the fluidics system of the cytometer. Trapped air
bubbles in the fluidics lines can dislodge and result in inaccurate data as they pass
through the flow cell, and salt deposits can clog the lines.

The Attune® Shutdown Solution is provided as a 10X solution that requires
dilution before use. Prepare a 1:10 dilution of the shutdown solution in deionized
water and add it to the water tank.

Store the Attune® Shutdown Solution at 15-30°C.

The Attune® Performance Tracking Beads are designed for use with Attune®
Cytometric Software to automatically characterize, track, and report performance
measurements of the Attune® Acoustic Focusing Cytometer. The beads are used to
define a baseline and conduct daily performance tracking of the cytometer. Each
vial contains enough beads for 50 measurements.

Store the Attune® Performance Tracking Beads at 2-8°C.

Note: Prior to use, you need to download the appropriate lot specific file
into the Attune® Cytometric Software for each new lot of Attune®
Performance Tracking Beads.
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Appendix D:

Attune®Cytometric Software Description

About the Software

Software Layout

92

The functions of the Attune® Acoustic Focusing Cytometer are controlled by
Attune® Cytometric Software.

By default, the software is installed in the C:\Program Files\ Applied Biosystems
folder and the Attune® Cytometric Software icon (i.e., shortcut) is placed on the
computer desktop and under Start» All Programs » Attune® Cytometric
Software.

& Note: If you need to reinstall the Attune® Cytometric Software for recovery
—  purposes, you must have Administrator access.

The Attune® Cytometric Software is a flexible data acquisition and analysis tool
that uses a browser view to:

e Design and perform experiments

¢ Define independent instrument settings and optimize data collection

e Carry out instrument performance checks and track instrument performance
e Acquire and record data

e Manage and process recorded data

The Attune® Cytometric Software has three main screens:
¢ Login - Used for logging into the software and running the Startup function

¢ Main Menu - Used for running and reviewing performance tracking tests,
creating new experiments, and accessing the current and stored experiments
of the operator. It consists of three panels:

- Performance Tracking
- New Experiments
- Experiment Explorer (Browse Experiments)

e Attune® Desktop — Used for controlling the Attune® Acoustic Focusing
Cytometer to run samples, generate data, and analyze results. Work Area

- Experiment Explorer
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Login Screen

The first screen that is displayed when you start the Attune® Cytometric Software
is the Login screen.

User Accounts The Attune® Cytometric Software has two types of user accounts, Administrator
and Operator.

o Administrators have full access to the software and can perform a variety of
tasks, including adding users, assigning data storage paths for user’s folders,
and changing and resetting passwords.

e Operators can access and modify their own Workspace and experiments, but
cannot add or delete users.

After a successful login, the software directs you to the Main Menu screen.

@ IMPORTANT! The default username and password for the Attune®
Cytometric Software are “admin” and “password,” respectively. After
logging in, assign a password to the administrator account as soon as
possible. To create additional users, see “Software Administration” on
page 133.
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Main Menu

Performance
Tracking
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After you log in to the Attune® Cytometric Software the Main Menu is displayed.

The Main Menu consists of three panels: Performance Tracking, New Experiment,
and Experiment Explorer (i.e., Browse Experiments).

v& applied
A b?gsyslems

Performance Tracking

New Experiment

=

St Tube Ecparment S i Epiment

No template A No template
defined defined

Click here to select one.

|

Click here to select one.

2 | Funcions 4

o Last performay

nce test completed on Wednesday, December 14, 2011 9:23 AM

A
No template No template
defined. defined.

Click here to select one. Click here to select one.

No template
defined.

No template
defined.

Click here to select one Click here to select one.

No template
defined

Click here to select one.

No template
defined

Click here to select one.

No template
defined.

Click here to select one.

New Experiment

Performance Tracking

Experiment Explorer

Performance 1racking advances to baseline calculations and pertormance tests
screens. It also provides the last completed performance test and the run status.
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New Experiment

Experiment
Explorer Panel

Attune® Acoustic Focusing Cytometer User Guide

New Experiment allows you to create a new experiment using a blank template or a
user-defined or preset template that is pre-populated.

The panel displays 10 user-defined experiment templates.

New Experiment

] T T F 2 —
) A ! . é i [ r" l No template
& - i - defined.
O 1 N - - e
“ 1 i - =z ’ N B Click here to select one
= F -~
i Tempiate B Tempate C Tempiate D None
No template No template No template No template No template
defined. defined. defined defined. defined.

Click here to select one Click here to select one. Click here to select one. Click here to select one Click here to select one

None. None. Browse Templates

Experiment Explorer (Browse Experiments) lists the experiments of the logged-in
operator. The experiments are stored in individual folders.

Browse Experiments

4 e My Experiments
I 12-14-2011 09 27 AM

1D 12-26-2011 06 34 PM
I 12-27-2011 05 53 AM

a I 12-27-2011 05 53 AM(1)
q Global Workspace
Ck Global Instrument Settings

4 [li] Compensation
[A4] Unstained Control
[A4] BLL
[M4] BL2
[ eLz
[A4] vi1
[Aa] iz
[A4] iz

4 ) 05-17-2012 02 30 PM
q Global Workspace
Ck Global Instrument Settings
[Mi] Compensation
4 .. Specimen

il Sample*
T semp

Double-clicking on any Sample within the experiment opens the Workspace.

Note: The Experiment Explorer object signified by the I or I icon
—J represents a sample. Instrument settings and Workspace are indicated by
bold font and an asterisk, respectively.
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Attune® Desktop

The Attune® Desktop is where you can run samples, generate data, and analyze the
results. It consists of:

e  Quick Access Toolbar

¢ Ribbon tabs (Home, Insert, Compensation, View, and Plate)

e Collection Panel

¢ Instrument Controls panel

e Plate Setup panel (for use with the optional Attune® Auto Sampler)

e Heat Map Setup panel (for use with the optional Attune® Auto Sampler)
¢ Instrument Status Bar

e Workspace

e Experiment Explorer

™ [ s} Quick Access Toolbar Attune® Cytometric Software v2.1 (Admin) = el )
B - et omveor | vew  pame
@& & ‘ o e
Lo e W AllEvents
Compensation  Compensation Setup e Compensation Ribbon
Setup Guide Compensation  Mafrix
Compensation Avaysis
Calection Panel v Ex Experiment Explorer X
Scatter BL1-A BL2-A 4 8 Wy Experiments =t
7 80 80 [J Global Workspace:
0 events 7o Glabal Instrument Sttings
2 60 0 [ Global Instrument Setting:
27 g H 4 [Ja] Compenation
< 3 8
93 0 @ [14] Unstained Control
Stop recording when 2 20 20 i 5
© Any of these conditions are met é 1 o o Al ez
) 200 et s =] PERYSEET R W s
[5 Min 0 Sec FSC-A (1076) BLL-A BL2-A (R v
[0 2000 wl [Ra] viz
© Record continuously Blaa VLiA Vioa (R vz
_— 100 100 100 £ 12-26-201106 34 PM
| 7 4 1227201105 53 AM
» @ £ 80 80 80
I - [ Global Worspace
Run_J|(Record ) {S5i00 |CCES ¢ 60 2 60 ¢ 60 [ Giobal Instrument Settings
\ 8 40 S 40 8 4 (K] Compensation
———— 4 (1227201105 53 AM(L)
ST 20 20 20 (i
Global Workspace
Depid 0000 - S 0 - o 0 [ Global Instrument Settings
Sample Dispensed 100 12 10t 10f 10° 12 10t 10 10° 12 10t 1c® K] Compensation
o BLIA VLA VE i
Acquisition Volume: 50 L. (170 L total draw volume) 4 @ 0515201211 17 AM
VL3-A Global Workspace
oA b
[ Globat Instrument Setings
25 ul/min 80 4 [li] Compensation
R —— e 3 Tl G Conr
§ (R oLt
40
[Ka] B2
20 [Kal o3
g (R vie
100 12 10t 10f (K] vi2
VL3-A (K4l viz |
¥ Collection Panel (3 Instrument Configuration 4 L. Specimen
o | Functons | Woropace: Defout ey

G e]

You can move, minimize, or hide the Experiment Explorer, the Collection Panel,
and the Instrument Panel.
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Collection Panel

Collection Panel allows you to initiate data collection, record events, define the
collection criteria, and select the collection mode and rate. The Collection Panel
also displays the run status.

If Collection Panel is not visible, select View > Collection Panel, Double-click the
Sample icon (UH) to access the Collection Panel

Collection Panel - B x

[ oo

0 events

<4——  Run status

0%

Stop recording when

@ Any of these conditions are met

10000 Eventson [All Gates ~

&5 Min 0 Sec

i oo L8 <—— Collection criteria

_) Record continuousky

Other Options

Display at least 10000 ~ ewents.

=

Recover unused sample

> l@ |
Run _ [} Record | (N | <4——  Collection controls

Sample Dispensed

ouL

Acquisition Volume: 300 pl (420 pL total draw volume)

100 /min <4—— Collection mode

<4+—— — Sample rate

{f Collection P... [ Tnstrument... [ Piate Setup [EjHeat Map 5.. |

<4— — Collection Panel tab
You may switch between panels using the tabs veiow e LESPECLLVE 11dLIIES.

|D; Instrument Configuration | gy Collection Panel

The Collection Panel displays the cumulative count and event rate of all events
that pass through the laser beam and register above the set threshold. The
progress bar provides an ongoing update of completion as defined by the user in
stop criteria.

00 ev/sec ~a—— Events/second

00 events -4—— Processed events

0% ~a—— Progress bar
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Using the Collection Panel, you can set the collection criteria for continuous
recording or you can prompt the instrument to stop recording when one or more
of the following specified conditions is met:

e Number of events for the specified gate Stop recording when
. (Z)Any of these conditions are met
e Elapsed time from the start of the 10000 | Event= oei| A1 Gaes (B
recording 5 |Min [0 |s=
¢ Volume of sample analyzed 4000 |l

(C)Record continuously

Record continuously allows recording continuously until the full draw volume is
exhausted.

Q Note: When using stop criteria (event, time, or volume), the condition that
is met first will take precedence. To ensure that only the desired criteria are

used, deselect the unwanted criteria.

The collection controls allow you to prompt the Attune® Acoustic Focusing

Cytometer to run your samples and record flow cytometric data using seven basic

commands: Run, Record, Pause, Stop, Clear, Save, and Next Sample.

¢ Run - Commences data acquisition without |
recording. You can observe the events in real
time as they are plotted in the Workspace, Run

allowing you to adjust experiment settings
such as the threshold parameters and PMT
voltages.

(o)

Record |

e Record - Initiates the recording of data in
a file.

L J‘en

Pause

e Pause - Pauses data acquisition or recording. ' i ‘ i

It also pauses the pumps. If you click Pause
during Run mode, the Save icon will appear.

e Stop — Terminates data acquisition or

mode, the Save icon will appear. Clicking
Stop during Record mode will stop the run

and save the data up to that point of the

acquisition.

recording. If you click Stop during Run
lResume I l

e (Clear — Deletes the data from the screen. It
refreshes the Workspace while the instrument
is in the Run or the Record mode.

e Resume — Resumes a paused run.

e Save — Saves the last 20,000 collected events
to the FCS file. If the sample has existing data,
you can append or overwrite the existing
data.

e Next Sample — Moves to the next Sample (IF). Creates a new sample using the

global Workspace if no additional samples remain in the experiment.
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The Sample Dispensed options in the collection panel allow you to choose between
High Sensitivity and Standard collection modes and to specify the draw volume. A
status bar displays the sample volume dispensed during a run.

Sample Dispensed

¢ High Sensitivity — Allows sample flow

ouL

rates Of 25 }.IL or 100 }1L per minl'Ite' Acquisition Wolume: 50 L (170 pL total draw volume)

e Standard - Allows sample flow rate of
25 uL, 100 pL, 200 pL, 500 pL, and 1,000 uL & 25 wjmn
per minute.

E Note: Using 1,000-uL-per-minute sample flow rate may require
—  adjustments to instrument settings.
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Instrument Instrument Configuration allows you to specify Threshold and Voltage parameters for
Configuration each of the Scatter and Fluorescence detectors on the Attune® Acoustic Focusing
Cytometer. To access, click Instrument Configuration tab on the Collection Panel:

i D, Instrument Configuration (57 Collection Panel
|

& Note: The example screens below show Scatter and Fluorescence detectors
— for the Blue/Violet configuration. For the Red/Blue configuration, the
detectors are FSC, SSC, BL1, BL2, BL3, BL4, RL1, and RL2.

TR v # % Threshold settings — Sets the minimum signal level

Lireeis NG for each detector to eliminate unwanted events and
FSC SSC BL1 BL2 BL3 V11 VL2 VL3 .
reduce noise.

617 10 10 10 10 10 10
The software records and analyzes only the events
with parameter values above the set threshold.

You can also combine all thresholds using Boolean
operators:

e If the “And” operator is selected, all the
thresholds set will have to be met before the
data is collected.

o If the “Or” operator is selected, data collection
begins when at least one of the thresholds is
met.

e If “Ign” (ignore) operator is selected, no
threshold is set for that detector.

=
1 1 ] ) I J

& Note: To record events using pulse width, you must set a >0 threshold
= value in the respective channel(s).

Voltage (mv) Voltage settings — Selects the voltage for each
FSC S5C BL1 BLZ BL3 VL1 VL2 VL3 deteCtOI‘.

160| | 210| |230| |2200| | 255| | 125 | 185| | 220
The range of voltage settings is 0-4,999 mV for all
channels.

To set the threshold and voltage values, adjust the
slider bars below each detector or enter the desired
number directly in the appropriate window.

E’ Note: You may also adjust the threshold and voltage settings by selecting
—  Instrument Settings window on the View Tab.
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Experiment Experiment Explorer lists Experiments in a hierarchical view and functions as an
Explorer interface for creating new Experiments and recording data.

Browse Experiments

e Experiments are groups of specimens
and samples that share common

AT Workspaces, instrument settings, and

Oee

£l

D 12-14-2011 09 27 AM

compensation settings.
D 12-26-2011 06 34 PM

() 12-27-2011 05 53 AM e FEach Experiment lists experiment

rl D 12-27-2011 05 53 AM(1)

fundamentals such as the global

s Workspace, global instrument settings,

r‘,@ Global Instrument Settings

4[] Compensation compensation settings, specimens, and
[li] Unstained Contral Samples_
[M4] BL1 .
[ha] 812 e  Only one Experiment can be opened at a
[Ma] BL3 time.
W v , , ,
- * You can organize your experiments in
o vi3 higher-level folders containing multiple

4 ) 05-17-2012 02 30 PM experiments_

@ Global Workspace

Dl Clobe rstramen Stings e You can rearrange Experiments,

Specimens, Samples, and Folders by

[Ai] Compensation

4 L Specimen drag-and-drop.

UH Sample™

My Experiments contains the saved experiments of the user.

Experiment contains the experiment fundamentals of a single experiment,
which are grouped under the Workspace, Instrument Settings,
Compensation, and Specimen icons (see below).

Global Workspace represents the area that displays Analysis objects (plots,
gates, and statistics views).

Global Instrument Settings allows you to optimize instrument settings such
as: Selecting Parameters, Defining Custom Parameters, Setting Threshold,
Setting Voltage values, and other Advanced Options.

Compensation opens the Compensation Setup window.

Specimen contains a list of the Samples to be analyzed.

Sample opens a Workspace (local or global) and instrument settings (local
or global). The active sample is indicated by a Visual cue.

e A Sample with no data (to be recorded) is represented by a tube icon.

e A Sample with recorded data is represented by a tube icon overlaid
with a disk.

Folders are used to organize your Experiments. Each Folders icon can
contain multiple Experiments and other folders.

Visual cue indicates the active Sample. It is located on the left side of the
Experiment Explorer. If the active Sample is off screen, the visual cue
indicates which direction (up, down, right) in the explorer tree the Sample
is located. Clicking on the indicator automatically brings the active Sample
into view on the explorer tree.
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Right Click on Sample (1): Right Click Options in the Experiment Explorer

Open Sample provide a number of functions that are specific
Tl aETE C to the object in the explorer tree:
View FCS File... °

Remaove FCS File(s)

Export FCS File(s)...

Export Statistics...
Print...

Sample level right-click allows you to
manage FCS files, manage sample level
Instrument Settings and Workspaces,
manage Samples, and view Sample
Properties:

P e Specimen level right-click allows you to
Save Instrument Settings As Global Create new Samples, manage SpeCimenS,
and apply the global Workspace to all
P lee e samples within a specimen.
Save Workspace As... . .
B e Workspace level right-click allows you to
Import Workspace.. open a Workspace, save a Workspace, and
A apply the global Workspace to all samples
A within the Experiment.
R S | N . . . . .
Fremesampe ¢ Right-clicking on higher level objects (i.e.
Sample Properties Experiment) provides functions to manage
Right Click on Specimen («): experiments.
New Sample
Duplicate Specimen
Delete Specimen
Rename Specimen
Export FCS File(s)...
Export Statistics...
Print...
Specimen Properties
Right Click on Global Workspace (50):
Opan Warkspace
Save Workspace As...
Apply Global Workspace to All Samples within Experiment
F2 F2 is a windows shortcut to rename files.

<\\;\, Note: A Sample name in bold indicates that the Sample 'EH Sample
—  has Sample-specific instrument settings.

A Sample with an asterisk after its name has a Sample- UH Sample®

specific Workspace.

A Sample with a bold name and an asterisk indicates '[H Sample*
that the Sample has Sample-specific instrument settings

and Workspace.

Sample Properties allow you to add notes to a sample.
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Workspace

Workspace displays Analysis objects (plots, gates, and statistics).

o Workspace types:
o Global ( |E) Workspace is common to all samples in an experiment.
o Local Workspace is unique to a sample and is denoted by an
asterisk on the sample.
o Compensation Workspace defines compensation controls and is pre-
defined.
e Creating a New Experiment from the explorer uses the default Workspace as
the Global Workspace; unless you specify another Workspace.
¢ Creating an experiment using a template uses the Workspace saved with the
template.
¢ Double-clicking any Sample (I or ) in the Experiment Explorer opens the
Workspace (Global or Local) associated with that Sample.
e Double-clicking the [l icon opens the Global Workspace for that experiment.
¢  The Global Workspace can be modified by directly opening the Global

Workspace () or at the Sample () level. To apply sample level changes to
the Global Workspace, right click on the Sample and select ‘Save Workspace

as Global’

e The Compensation Workspace is accessed via the Compensation Setup
Guide or by double-clicking on Compensation (/). New screen

Home | Inset Wi

e

B I U Avdy
Clipboard Font

Attune® Cytometric Software v1.2.5 (Admin)
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Callection Panel TEX Experiment Explorer vEX
4 8 My Experiments
U oo | Sare R
» D 11162010 1109 AM(L)
0 events » O 1116201011 18AM
i Scatter - Sample Blue Laser - Sample ) Violet Laser - Sample / i
g ! g [ workspace:
i = 10
s 4 (3 instrument settings
Stop recording when 1 1
! - 4[] Compensation
(@ Any of these conditions are met LR v ” p
] 10000 |Events on [0 Gates_© G| - i il [fg Unstined Contrl
s . = | A o] [l BLL
2 - 1 17 ’ ]
&[40 | 1 (K] s2
ORecord continuously 10" 0 K] o5
10 . . 10" e [l vt
o=l 1 1 00 1 100 10! 102 10 10t 105 1f I v
’ ‘ @ ” BLIH Wi s
Run || Record | Stop 4 L Specimen
T ssmple
‘ ‘Next Samels
@ 11182000922
Transit Time, 2 1118201003 20 PM
Semple Dispened: o 4 1311200 2238 01)
0000
acquiston Volume: | 300 | (47C [l Workspace
s [ Instrument Settings
ligh Sensitivi standard
o L standad | 1] Compensation
100 uumin 4 11112000 1234 PR)
e [ Workspace
g/ Collection Panel [ Trstrument Gonfi Instrument Settings
[y cocion o 5 = A % o
" - Workspace: Default Instrument Settings: Default
Qe G| T
Workspace




Ribbon

Clipboard
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B

Insert

I 10 Av v Delete

Font Editing Size and Position Global Analysis

The Attune®Cytometric Software uses the Microsoft Ribbon interface. The Ribbon
consolidates related functionality by organizing control elements in logical groups
under contextual tabs. Each tab relates to a type of activity.

The ribbon tabs are the Home, Insert, Compensation, View, and Plate and they
contain common commands that apply only to the selected item. Objects that are
not available as a function in a particular context are shaded gray in the tab.

NS

|- Home Insert Compensation View Plate

E Note: The Plate tab is for use with the optional Applied Biosystems®

— Attune® Auto Sampler. Refer to the Applied Biosystems® Attune® Auto
Sampler User Guide (Part no. 4479066) and the Applied Biosystems® Attune®

Auto Sampler Quick Reference Guide (Part no. 4479067) for instructions.

Home

The Home tab provides editing and formatting functions for the Workspace, and
is organized into five sections: Clipboard, Font, Editing, and Global.

Compensation Wiew Plate

Select Al | | e gl P [ Ty Load Events:

Unselect 'ﬁ (2=

Options  Main  Transaction
Menu Log

All Events -

o Clipboard allows you to cut, copy, and paste selected objects and text in
the work area. It also contains Undo () and Redo (') buttons.

e  Font allows you to pick the font size, style, color, and background color
used for the selected object in the work area.

e Editing contains shortcuts for selecting, unselecting, and deleting any of
the objects in the work area.

e Global contains the shortcuts to Options, Main Menu, and Transaction
Log.

\\j Note: Options menu allows authorized users to perform administrator and
= user management functions, determine file and folder pathways, and
change the default settings for general formatting.

Attune® Acoustic Focusing Cytometer User Guide



Insert

The Insert tab enables you to insert analysis objects (i.e., plots and gates) as well as
text, images, and statistics into the Workspace.

- Home Insert Compensation View Plate

Histogram Dot Density | Rectangular Oval Polygon Quadrant Derived His
Plot Plot Plot Gate Gate Gate Gate

Plots Gating Tools Other Analysis

i

@ 1‘\_] u j Load Events:
=

AllEvents
Marker | Text Image Statistics

The Insert tab consists of Plots, Gating Tools, and Other.

e Plots allow you to insert a Histogram Plot, Dot Plot, or a Density Plot into
the Workspace.

e Gating Tools allow you to isolate a region in a selected plot for analysis.

e Other allows you to display the statistics corresponding to a selected plot
in the Workspace. It also allows the insertion of text and images into the
Workspace.

To display global statistics, click Statistics without selecting a plot. Global
statistics contains data of all the gates in the Workspace.

To display local statistics, select a plot in the Workspace and then click
Statistics. Local statistics only displays data pertaining to the selected
plot.

Compensation

The Compensation tab allows you to access the compensation functions of the
software

- Home Insert Compensation View Plate

(2% N . |I|| v, [ |I|| . Load Events:

g & [0 s =

S ‘~' AL - AllEvents  w
Compensation Compensation Setup Use Compensation

Setup Guide Compensation Matrix

Compensation Analysis

Refer to Calculate Compensation on page 26.
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View
The View tab facilitates the configuration of an experiment, and allows you to

view FCS file contents of the active sample, modify instrument settings, and
customize the Workspace. It consists of Experiment, Workspace, and Show/Hide.

- Home  Inset  Compensaon  View  Plate
~ r = e 4] Collection Panel 7] Plate Setup ¥ Plste Reset Windows Layout Losd Events:
8@ > oR0s3a B —
g | Instrument Cenfiguration ] Heat Map S Print Area AllEvents v

FCS  Instrument Save As Z Refresh Page Print Quick  Print Save As o
File Settings ~ Template n Al Setup Print  Preview PDF | Expeniment Explorer | Piate Layout Status

Experiment Workspace Show / Hide Analysis

<\\;§, Note: The Flow Cytometry Standard (FCS) is the standard format for flow
— cytometer data files and provides the specifications needed to completely
describe the data sets within.

e Experiment allows you to view the FCS file for the active experiment,
modify instrument settings, and save the experiment as a template.

o Workspace allows you to zoom in and out of a selected plot, refresh all
items in the Workspace, change the Page Setup settings (page size, order,
orientation, and margins), and print the Workspace.

e  While zoomed in on a plot, you can toggle between plots using the Tab
key (left to right) or Shift+Tab keys (right to left).

e Show/Hide allows you to choose windows (i.e., Collection Panel,
Instrument Configuration, and Experiment Explorer) to display or reset
the windows layout.

You can hide the script dialog boxes to make the Workspace accessible for
data analysis by un-checking the Status box.
Print Area can also be turned on or off by clicking the checkbox.
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Instrument Status  [nstrument Status Bar indicates the status of the Attune® Acoustic Focusing
Bar Cytometer and displays cytometer errors as error indicator icons. It also contains
the Functions menu, Experiment Summary, and the Zoom tool.

e * ‘ ) Layout: Default Instrument Settings: Specimen Tube T y
! ‘ o A 7N « | Dunciions 4 Scripts Status: None Compensation: None 100
System Status Functions Experiment Zoom
Status Indicators Menu Overview Tool

Status Indicator Icons

Startup successful and the cytometer is ready for operation.
System errors encountered (low fluid levels, pump timeout, etc.).
Startup required.

Cytometer connected, but there may be a problem with running one of the
cycles. This warning often requires you to clear the error by selecting Clear
Error from the Functions menu (see below).

QGE ©

Fluid levels do not meet the required minimum.

g O

L]

System detects problem with lasers.
Top cover is open.

Tube lifter is not engaged in the top position.

Instrument is not detected (USB cable not connected or the cytometer is not
powered on).

e

E Note: The Instrument Status Bar displays a status indicator icon only if the
—  cytometer encounters the specific error symbolized by the icon.

Functions menu allows you to perform:

e De-bubble e Rinse e (Clear Error
e Wash e Startup e Status
e Unclog e Stop

Zoom tool allows you to zoom in and out of the Workspace and to scale it to fit a
single page for printing (when Print Area is visible).
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Quick Access
Toolbar

AB tab
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Quick Access Toolbar contains the Undo, Redo, and Options buttons.

W 5Ly

Home Insert

I‘_E:"IL'- Undo — deletes the last action.
-]{_.3_‘1 Redo — restores the last action.

™ Options — opens the Options window, which is used to customize the
Attune® Cytometric Software. Some options are user-specific, while others
are application specific (i.e., global to all users) and customizable only by
an authorized user.

=== Show Main Menu Screen — opens the Main Menu Screen.

= Customize Quick Access Toolbar — allows you to change the location of the
Quick Access Toolbar or to minimize it.

E Note: You can add any button in the Ribbon and within the AB Button to
— the Quick Access Bar by right-clicking the button and selecting Add to
Quick Access Bar.

The AB tab allows you to save FCS Files, Workspace, and Instrument
Settings, and to print the Workspace objects. It also lets you open the
Options window, access the Main Menu Screen, and logout of the
software.
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Instrument Settings

Instrument Settings allows you to specify Acquisition Parameters, Threshold,
Voltage, Custom Parameters, and Advanced Options (only available to users with
administrative privileges) on the Attune® Acoustic Focusing Cytometer.

To access, click Instrument Settings on the View Tab or double click the
Instrument Settings icon (¥) within the experiment.

W e

FC5  Instrument Save As
File Settings  Template

Experiment

Parameters Tab Parameters tab allows you to select parameters for acquisition and name
parameters at a global level.

®_ Instrument Settings (Experiment 10-26-2010 02 56 PM) (] | = Instrument Settings (Experiment 07-01-2011 09 34 PM)
Instrument Settings Instrument Settings
You can use the following options to update instrument settings. You can use the following options to update instrument settings.
Parameters | Threshold | Voltage | Custom Parameters | Advanced Options Parameters | Threshold | Voltage | Custom Parameters | Advanced Options
[include Event Count. i [include Event Count:
[H1nclude Time [include Time
Enabled Name Area Height Width Enabled Name Area Height Width
[Fsc ] [rsc ]
[ssc ] [ssc ]
E | [Ba |
(B2 | (B2 |
(83 ] [3 ]
[ | ER |
[z J [ru ]
[vz | [R2 |

e The software records and analyzes only the events with selected parameters
(default is all but “Include Event Count” selected).

o To select or deselect parameters, check or uncheck the desired parameters.

¢ Renaming parameters from the Parameters tab changes the parameter name
within the FCS file.

@ IMPORTANT! If you are acquiring greater than 500,000 events, you must
limit the number of acquisition parameters to 10 or fewer. Note that Event
Count and Time are also considered parameters. For example, you may
select Area for all channels plus Event Count and Time for a total of 10
parameters, but not Area and Height for all channels, which would total 16
parameters.
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Threshold Tab

Threshold tab allows you to set the minimum signal level for each detector to
eliminate unwanted events and reduce noise.

The software records and analyzes only the events with parameter values above
the set threshold.

8 Instrument Settings (Experiment 06-16-2010 02.36 PM) (%] | = Instrument Settings (Experiment 07-01-2011 09 34 PM)
Instrument Settings Instrument Settings

You can use the following options to update instrument settings.

You can use the following options to update instrument settings.

Parameters | Threshold | Voltage || Custom Parameters | Advanced Options |

Parameters | Threshold | voltage | Custom Parameters | Advanced Options |
Please enter a threshold (x1000) for each Use the options in thy ding drop down list Please enter a threshold (x1000) for each parameter. Use the options in the corresponding drop
to customize your threshold. down list to customize your threshald.

FsC ssC BL1 BL2 BL3 vi2 vi3 FsC ssc BLL BL2 BL3 BLa R RL2
koo |10 | [10 | [10 | [10 | [10 | [10 | [10 ] [ 100] | 10] | 0] | o] | 0] 10| 10] 10
(-} [} (] (- | O (- (- | (-} (-} (-] (- | (- O (- O O
[or 1] [1gnore || [1anore [ [1anore v [1gnare ] [1gnore v [1anore [w] [Tgnore v [or 1| [1gnore (v [tgnore | [1gnore (| [1gnore (| [1gnore (v [tgnore (v [1gnore v

G TN T

You can also combine all thresholds using Boolean operators:

If the “And” operator is selected, all the thresholds set will have to be met
before the data is collected.

If the “Or” operator is selected, data collection begins when at least one of the
thresholds is met.

If the “Ignore” operator is selected, the detector is ignored for thresholding
purposes.

Voltage Tab Voltage tab allows you to select the voltage for each detector.

% Instrument Settings (Experiment 06-16-2010 02.36 PM)

[%] = instrument Settings (Experiment 07-01-2011 09 34 PM)
Instrument Settings

Instrument Settings
You can use the following options to update instrument settings.

You can use the following options to update instrument seftings.

Parameters | Threshold | Voltage | Custom Parameters | Advanced Options

Parameters | Threshold | Voltsge | Custom Parameters || Advanced Options
Please enter a voltage for each parameter (mv). Please enter a oltage for each parameter (mV].
FsC SSC BL1 BL2 BL3 Vi1 vz Vi3 FSC S5C BL1 BL2 BL3 BL4 RL1 RL2
1600 |[2100 200 |[2200 |[zss0 |[12s0  [[1ss0  |[2200 | [ aeoo|[  Raoo|[  zoo|[ 20| [ asso|[  =sso|[ 1zso|[  1ss0
o (- | ] - (-}
[} (- | =] (-} c - | -]
(] [}
L -

O T T

The range of voltage settings is 0—4,999 mV for all channels.

To set the threshold and voltage values, adjust the slider bars below each
detector or enter the desired number directly in the appropriate window.
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Custom
Parameters Tab

Advanced Options
Tab

Custom Parameters tab allows you to create derived parameters.

®  Instrument Settings (Experiment 06-16-2010 02.36 PM)
Instrument Settings

You can use the following options to update instrument settings.

9] e You must define a derived
parameter prior to

acquisition. A custom

parameter cannot be created

for previously recorded

data.

[ Parameters | Threshold | Voltage | Custom Parameters | Advanced Options |

Name:

I ()
Param 1: Oper 1: Param 2: Oper 2: Modifier:

| | V[ ¥ |
Enabled Name Formula

e  Only parameters that are
enabled (see Parameters
Tab, page 109) are available
in the drop down parameter
list.

S ST T

Advanced Options tab allows users with administrative privileges to set manual
Laser Delay, Area Scaling Factor, and to disable the bubble sensor. All users have
access to LinLog Linearization Parameter found under Advanced Options.

u Instrument Settings (Experiment 10-26-2010 02 56 PM)
Instrument Settings

You can use the following options to update instrument settings.

| Parameters | Threshold | Voltage | Custom Parameters

Advanced Options

Laser Delay

[1se following manual laser delay:
Last performancs test laser delay: 308

Blue Laser Area Scaling Factor

[ use following manual blu laser area scaling factor:

Last performance test blue laser area scaling factor: 1.24

Violet Laser Area Scaling Factor

[use following manual viele laser arez scaling factor:

Last performance test violet laser area scaling factor: 1.17

Oth

Instrument Settings

You can use the following options o update instrument setfings.

Parameters | Threshold | voltage | Gustom Parameters

Advanced Options

Laser Delay

Last performance test lassr delay: NJA

Red Laser Area Scaling Factor ————————————
[use following manual Red laser area scaling factor:
Last performance test Red laser area scaling factor: NJA

Blue Laser Area Scaling Factor ——————————
[Juse following manual Blue laser area scaling factor: [1 |
Last performance test Slue laser area scaling factor: N/A

Qther Options ——M908@ @
Enable bubble sensor

T

Save As...

Laser Delay: Sets the time delay between the two lasers, which is calculated

during the Performance Test.

Area Scaling Factor (Blue and Violet or Red and Blue): Sets the value to scale
height and area to equivalent values. Area scaling is calculated during the

Performance Test.

Enable bubble sensor: The bubble sensor is enabled by default but an
administrative user may wish to disable the sensor

®

Note: Save As saves the Instrument Settings as a
printable PDF file. The file contains all the

parameters, voltage, threshold settings, and hardware codes. The report
does not contain the instrument name, institution or compensation matrix

(if created).
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Customizing the Attune® Desktop

The Attune® Cytometric Software allows you to design the layout of the Attune®
Desktop and how the different components are positioned. The Attune® Desktop
is designed to be customizable to your needs and works similar to other Windows
based applications. You can choose to show or hide the different components by
checking the appropriate boxes in the View tab (see page 106). The Attune®
Desktop is configured per user.

Moving and ¢ You can move each panel or component of the Attune® Desktop as desired.
Resizing e To delete an item such as a chart from the Workspace, simply click to select it
Workspace Objects and then press Delete on the keyboard.

e To resize a window or panel, click on the edge of the window and drag the
edge to resize.

¢  Workspace windows are by default docked around the edges of the main
window. To move a window (e.g., Experiment Explorer), click on the title bar
and drag it to the desired location.

e Right-click on the title bar of any window to S — -
show docking options. Note that floating « 8 we zm:;
windows are not docked; you can move them « avS Az; i :e
around but cannot dock them to any edge. g “Ern i

e Tore-dock a window, left-click on the title bar and drag the
window into the desired area on the docking map that appears on
the work area.

ttune® Cyometnc Sofruare v2.1 (Acmin) = |
ceation Arsiysis
Caliection Panel i
0 ev/sec ) _ /
| - Sample 1 & Double click to edit text Click and drag title bar to move
0 events
0%
Scatter - Sample Blue Laser - Sample Violet Laser - Sample
top »- | —
| rd
i e
) ! -
4 § 10y g 10! "
g g b
e : Lo | g
} ] »
i

FSC-H (106 BLIH T VLIH
8 S5C

Acquisition Volume: 50 L (1701 L total draw voiume) o
o _— Spscmen Name: Specimen Right-click plet to customize
tighsersivry EN o Sumple
25 ulimin Name Bvert ot % Parent
L— s Quees Qa5 -
O B R
-— Click on edge and drag to resize 6 vu
K vz
| NEE]
allection Panel [ Instrument Configuration 4 & Specimen

= = Workspace: Defautt Instrument Settings: Default
CAEEE | Functions A EEE tion: default

FIEAL b
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Customizing the Workspace

Working with .
Workspace Objects

Cut/Copy/Paste
Functions

Click and drag objects to move them in the Workspace.
To resize an object, click on its edge and then drag the edge to resize.
To select multiple objects, click on the first object, press CTRL, and then click

on another object. Selected objects are enclosed by a blue border.

Scatter - Tube Blue Laser - Tube

The selected Tube has no data. | Parent gate has no data.
@107 |

To delete an object such as a chart from the Workspace, click to select, and
then press Delete.

To undo or redo an action, click on the appropriate icon from the Quick
Access Toolbar (see page 108). You can also use keyboard shortcuts.

You can invoke Cut/Copy/Paste commands using context menus, the ribbon, and
keyboard shortcuts for all Workspace objects.

For example, right-click on a Dot Plot to display the context menu. The context
menu that is displayed depends on where you right-click on the plot.

Attune® Acoustic Focusing Cytometer User Guide

4 BL2-A

1 Copy Ctri+C 50

Blue Laser - Sample Red Laser - Sample

Time
- FSC-A
150 SSCA

2 BLI-A

P = BL3-A
T & 100 Blaa
i @ RLL-A
RL2-A
Cut Ctri+x FsCH
SSC-H
Delete Del BU-H
" Duplicate BL-H

10° 1 Save As.. 0 BL3-H | S

BLH 5 6 7 8

Statistics [ (1076)

Back Gates 3 sscw
New Gate 3 BLI-W
Set Population 3 v BL-W

Customize... BL3-W

cut Cerlx
Cerl+C

Del

You can paste objects that are copied into the Workspace or into a Microsoft
Windows application that supports pasting.

You can drag the Workspace objects to a new location while holding down the
CTRL key. The selected item is duplicated when you release the mouse
button.

You can press the Esc key to cancel regular or copy drag. This still preserves
the selection and the canceled drag is not considered as an undo action. You
will still be able to undo an action previous to the aborted drag, if any.
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Multiple Copy and
Paste Functions

Customizing Text
Objects

Customizing the
Compensation
Workspace

114

You can paste multiple copies of an object or different objects onto the work area.
When pasting objects, the most recently pasted item will be on the top.

Violet Laser - Sample

Violet Laser - Sample

vi2-H
vL2-H

S —
10° 10" 102 10° 10* 10° 108
VL1-H

Right-click on the text object and select Customize to open the Customize
dialog box.

The Compensation Workspace is pre-populated with plots corresponding to the
compensation controls selected during the compensation setup.

e The Layout of the Compensation Workspace cannot be changed.

e Objects that can be customized include the R1 and R2 gates, and the scale and
range of all plots.

e To customize the scale of the X- and Y-axis right click on the axis and choose
ScalebLinear or Scale»Log.

e To customize the scale and range of the X-and Y-axis right click anywhere on
the plot and choose Customize:

Customize
You can use the following aptions to customize warkspace items
X Axis ¥ Axis
Paramster: FSC-A Paramster: SSC-A
Scale Scale
Type: | Linear v Type: Linzar v
Range: () Automatic Range: () Automatic
(@ Manual (@ Manual

Minimum: | 0 Minimum: | 0

Maximum: | 8388508 | Maximum: | 8388608

e The Linear scale is the only option on the Y-Axis of the histogram plots.

Attune® Acoustic Focusing Cytometer User Guide



Customizing Plots

Plot Context Context menus can be used to open the plot menus to customize the parameters for
Menus an experiment. The context menu that is displayed depends on where you click on
the Plot.

Blue Laser - Sample 200 Red Laser - Sample

Time

S5C-A
s 150 BL1-A
E BL2-A
BL3-A
BL4-A
RL1-A
RLZ-A
FSC-H
S5C-H
BL1-H
Delete Del BL2-H
Duplicate 0 BL3-H
Save As... BLaH

BL2-W
=]
5

Cut Ctri+X 50
Copy Cri+C

RL1-H
Statistics RLZ-H
FSC-W
SSC-W
BL1-W
. . L Set Population 3 :j::
Right-click on the inside P — 2w
to open this menu i

Back Gates 3
New Gate 3

<

RL1-W

RL2-W

Qut CerX
Copy Cerl+C
Delete Del
Duplicate

Save As...

Scale 3

Customize, ..

Right-click on the plot and select Customize to open the Customize Plot dialog
box. Customize Plot dialog box has six tabs: General, X Axis, Y Axis, Samples,

Gates, and Back Gates.
Blue Laser - Sample
105 ya
10° 4 o
4 Cut Ciri+x
I 107 1 Copy Ctri+C
gﬂj 103 ] Delete Del
Duplicate
q 02 4 Save As...
10" 4 Statistics
0 i S
10 0 1 Back Gates v g
10 10 New Gate 3 b
Set Population 3 |
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General Tab

116

General tab allows you to select the plot type and the density of the displayed
events, and enter the chart title. It also allows you to select the text styles and the
border used for the plot Title.

Customize

]|

Customize

You can use the following options to customize workspace items

General | X Axis | Y Axis | Samples | Gates | Back Gates |

Plat Type: Dot Plot -

Density: 100 ()
Chart Title

Text:

Style
[Tahoma > 975 «

Blflﬂ Av v

Border

width: [0 [ &~

Include Name of
] Experiment ] Specimen Sample Parent Gate

¢ Plot Type selects Histogram, Dot Plot, or Density Plot.
e  Chart Title allows you to enter the chart title.
e Style defines the font, size, and background.

e Border specifies the width and color of the border.

¢ Include Name of allows you to include Experiment, Specimen, and

Sample, and Parent Gate names in the chart title.

E Note: You can define default styles for all Workspace items using the

Options dialog box. Default styles are saved for each user.
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In the Include Name of section, check the desired box (es) for Experiment,
Specimen and Sample to include those names in the title. The plot title is updated
when you switch Samples.

For example, if you checked all three, the chart might look as follows:

Blue Laser - New Experiment - Specimen - Sample

p

. :
* 10° 108
BLI-H

¢ Some of the options in the General Tab are specific to certain plot types.

Use Shading Allows you to shade the area below a Histogram Plot.

Resolution:  |1024 x 1024 |+ Alhows you to determine the resolution of Histogram

and Density Plots.

Density: 100 Allows you to determine the
percentage of data points
displayed on the selected Dot
or Density Plot.

e Todisplay an overlay plot, drag and test sample

drOp any Sample lntO any eXiSting vao ] test n.uuulil.- unstained cells |
plot except itself. The legend is o0 ] |w
displayed above the plot with the ] f L
names of each Sample in the . 1004 q| |
corresponding color. When E 804 | '\ r1
. . 60 . |
overlaying histograms, ensure that ] " | |
] A
the resolution is the same; 0 ,,I"lv-" ) ’\ |
. 201 % W 1
otherwise, the graph may not look , 1 Wb
the same. 102 10I3 ml“ mls 10IG
Repeat the process to have more A

than one overlay.

¢  Only Histograms and Dot Plots can
have overlays.

¢ To display plots side-by-side, drag and drop any Sample from Experiment
Explorer into a blank area in the Workspace and set the plot to the desired
type and parameters.
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X- and Y-Axis Tabs Using the X-Axis and Y-Axis tabs, you can change the parameter and scale type, set
the range, and format the appearance of the X- and Y-Axis title bars, respectively.

The X-Axis and Y-Axis tabs have the same options available.

Customize x
Customize

You can use the following options to customize workspace items

[ General | XAxis | Véxs | Somples | Gates | BockGates |

Parameter:
Scale Title
v e ot Tet:  BLIA
Range: ) Automatic style
(] |Tahoma v| |9‘?5 v|
Minimum: | 100 . Av Prw

Maximum: | 6300000 Border

width: |0 2 o

e Use the Parameter drop-down menu to select the  Parameter: v
parameter you want to display. s

¢ You can set the Scale type to Linear, Log, or s
Linlog. ranga:  (2) Automatic

¢ If Range is set to Automatic, the scale will Al
incorporate the entire range of the data limits. Minimum: [0 |

e If Range is set to Manual, you can specify the Maximum:

scale to be displayed by entering the minimum
and maximum range for the chart.

E Note: You can right-click directly on the plot axis to change the parameter
—! and/or the scale.
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Samples Tab You can use the Samples tab to turn samples on and off, set the color for each
overlay, remove samples, and change the way the samples are displayed.

Customize
You can use the following options to customize workspace items
| General | xaxs | Yexis | Samples | Gates | BackGates |

You can drag and drop any sample from the Explarer tree to the workspace area to display the sample
side-by-side. You can alsa drag and drop a sample from the Explorer tree over an existing Dot or
Histogram plot to display it as an cverlay.

Options

Display Moda:! Display active sample and selected samples below only v|

Available Samples

Enzbled Experiment Specimen Sample
Experiment Specimen Sample 2 . (=}
Experiment Spedmen Sample 3 . [ ]

e In the Samples tab, you can select one of the following display modes:
1. Display active tube only.
2. Display selected tubes below only.
3. Display active tube and selected tubes below only.

e Todisplay a Sample as an overlay to the active Sample, check the Enabled
box for the Sample

o To set the color for Sample, click the Set Color square to display the Set Color
dialog box and then select the desired color for the sample.

e To remove a sample from the list of overlaid samples, click the trash icon (T).

E Note: If you disable all available sample overlays, the display mode will
= default to Display active tube only.
When you re-enable the overlay samples, you must change the display
mode back to Display selected tubes below only or Display active tube and
selected tubes below only.
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Gates Tab

Back Gates Tab

120

In the Gates tab, you can add gates to the selected plot and manage them. Derived
Gates can only be managed via this tab and can be accessed from any plot.

Customize ®

Customize

You can use the following options to customize workspace items

General | XAds | Yiis | samples | Gates | BackGates |

You can add a gate to any plot using the toclbar or context menu. Histogram gates are only valid for
histogram plots, and the other gate types are only valid for dot or density plots. Manage your gates
below.

Available Gates

Name
Or o
Or2 )

¢ To show or hide a gate from the plot, click the box next to the desired gate.

e Toremove a gate from the plot, click the trash icon ().

You can use the Back Gates to display descendent gate data on a plot.

Customize 53]
Customize

You can use the following options to customize workspace items

General | XAxis | YAus | Samples | Gates | BackGates |

‘You can add a back-gate to a dot plot using the context menu. Gated plots can only display back gates
from descendant plots. Manage your back gates below.

Available Gates —— Back Gates —MM
[T

O r3

e Toapply a gate to the selected plot, select the desired gate and click Add.

e Toremove a gate from the selected plot, select the desired gate and click
Remove.

¢ To change the order of display for the back gates, re-arrange the back gates
using the Move Up or Move Down buttons. In the plot, back gates at the top of
the list are displayed on top of back gates down the list.
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Gating Tools

Gate Types

Gating Tools allow you to isolate a region in a selected plot for analysis.

ODoOC H® M

Rectangular Owval Polygon Quadrant Derived Histogram Bi-Marker
Gate Gate Gate Gate Gate Gate

Gating Tools
A Rectangular Gate can be inserted into a Dot Plot or Density Plot.
An Oval Gate can be inserted into a Dot Plot or Density Plot.

A Polygon Gate can be inserted into a Dot Plot or Density Plot.

To use a polygon gate, click on the plot to insert a “handle.” Continue to insert
“handles” to draw the gate around the population of interest. To complete the
process, click on the original handle or double-click when inserting the last
handle. You can stretch the polygon to any shape by clicking on a handle and
dragging it to the desired location.

A Quadrant Gate can be inserted into a Dot Plot or Density Plot. Quadrant Gates have
an additional feature that allows precise population demarcation. These gates can
be “bended” to fit a population better.

In the Default Quadrant Gate, all lines are connected and form right angles, as
seen in the example below.

Lysed Whole Blood

: \ Middle of Line

Segment

6 ]
10 CD3-CD8+
5 ;
10 * End of Line
+ e Segment
S . '
8 10
m
[+
o R
g 5000 4
h
-
-

2500

0
CD3+CD8-

2500
"

BL1-CD3 FITC-A
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In a Flexible Quadrant Gate, the lines that demarcate the populations
of interest do not form right angles, as shown in the example below.

Lysed ¥hale Blood

End of Line
Segment

Middle of Line

. ‘: . — Segment

VL1-CD& Pacblue-A

2600 2500 i0* 1
BL1-CD3 FITC-A

e Grabbing the middle of a line segment allows for the
independent movement of each arm.

e Grabbing the end of a line segment allows you to hinge the arm
about its attachment point.
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(I) A Derived Gate can be created as long as there is at least one gate
. present in the Workspace. You can create them with any or no plot
Dervee selected.

There are three types of Derived Gates:

e AND (Intersected) gates include all events that are shared
between two or more individual gates:

SCATTER R3 AND R4
84 K 84
71 71
6 64
LR £5]
=y R3 AND R4 2,
< B < E|
] VY
24 24
14 14
0 (JE SN RIAND R
0 1 2 3 4 5 6 7 8 0 1 2 3 4 5 6 7 8
FSC-A (10°6) FSC-A (10°6)

e OR (Joined) gates include all events that are found within
two or more individual gates:

SCATTER R1 OR R2

8 B i LE|

7 71

6 6

£s £

g, R1OR R2 2,1

< <

#o ol

2 24

1 14

0 0 T T

01 2 3 4 5 86 7 8 001 2 3 4 5 6 7 8

F5C-A (10°6) FSC-A (10°6)

e NOT gates include all events found outside the gate:

SCATTER
8 EE
7 7
6 6
é 5 é 5
2y NOTR1 2y
8 )
2 2
1 1
0 04 4 4
012 3 456 7 8 3 4 5 6 7 8
FSC-A (1076) FSC-A (1076)

Derived Gates can also be used to create other derived gates:

u Derived Gate El
Derived Gate
Select gates and operator for a derived gate.

Gate Definition

Gate Color

T

ECE ST
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R1ORR2 NOT (R1 OR R2)

8 8
7 T
6 6
Sa NOT (R1ORR2) S4
#a e @k
2 2
1 1
0 T T 0
0 1 2 3 4 5 6 7 8
FSC-A (10°6) FSC-A (10°6)

\\J Note: The color of the derived gate cannot be changed once it is created.
= You must select the color during the initial creation.

[M] A Histogram Gate can only be inserted into a Histogram Plot.
Histogram

Gate

|::| A Bi-Marker Gate can only be inserted into a Histogram Plot.

Bi-Markesr
Gate

Customizing Gates Right-clicking on a gate allows you to customize the gate name, opacity, fill color,
population color, and border width and color.

Customize 3]

= Customize
: You can use the following aptions to customize workspace items
: General |
N 3 General
o
= Population
T |
O 34 Opacty (%): |25 3| &v Bv
] e
?:'b 1 Border
2 3 wih: (2 2| &
1
T Delete Del
Hids
Create Daughter Flot 4
Export to FCS Fle... e

Clicking on the gate name also allows you to edit the gate name without opening
the customize window.
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Export Gate to FCS Right-clicking on a gate also allows you to export the gate data to a new FCS file.

File e Exporting the gate data to a new FCS only exports the events that fall within

the gate.

Whole Lysed Blood Scatter Whole Lysed Blood Scatter
B T

55C-4 (10°6)

55C-4 (10°6)
=y

0 T ke 01 S tymets
2 3 4 ] B 2 3 4 ] B
FSC-A (1076) FSC-A (1076)
Before Export After Export

e If compensation is applied, you will be prompted to store the compensation
values in the FCS file. The matrix is stored using the $Spillover keyword.

B Attune™ Cytometric Software rZ|
e FCS file contains no compensation matrix. but the active experiment has a compensation matrix set.
Would you like to store this matrix in the FCS file?

- O T
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Other Gate Options

126

Right-clicking on a plot brings up a contextual menu that allows you to:

Show Gates: This option allows you turn on or off the display of selected
gates within the plot.

Back Gates: This option allows you to display descendent gate data on a plot.
Only gates that are descendents or are at the same level within the hierarchy
of the gates are available for display. Back Gates can only be displayed on Dot

Plots

New Gates: This option allows you to create new gates (Rectangular, Oval,
Polygon, Quadrant, Histogram, and Bi-Marker) without inserting them from
Gating Tools grouping within the Insert tab of the Ribbon menu.

Set Populations: This option allows you to choose to limit the data displayed
on a plot to a given gate. It makes the plot a daughter of the upstream gate.

Create Daughter Plots: You can also create plots as daughters from other
plots by right clicking on a gate of interest, selecting Create Daughter Plot,
and choosing the type of plot to display (Dot Plot, Density Plot, or
Histogram).

S2C-A (10°0)

1 R

| showGates ]

Scatter - Test Sample

TR
Cut
Copy
Delete
Duplicate
Save As...
| v Use Compensation
Statistics

Back Gates
MNew Gate

Set Population

Customize...

Cirl+Xx
Cri+C

Del

-

v v v

r .

S2C-a (10°0)

Delete Del
Hide

Create Daughter Plot 3
Export to FCS File...
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Working with Statistics

Types of Statistics  Statistics fall into two categories, Global and Local statistics.

e Global Statistics show statistics for the full gating hierarchy from All Events
down.

o Local Statistics show statistics for a particular branch of the gating hierarchy
and are plot specific. That is, only gate data relevant to that plot (parents and
children) are displayed.

Global Statistics Global statistics display the entire gating hierarchy for all plots.

Experiment Name: 4 Peak Performance Testing

041310 AM

Spacimen Mame: Specimen T 041310 AM 50 041310 AM
Sample Name: 041210 AM g1 ) A | o
g Ao T Y ] H
Name Event Count MedianX | % CM. X e o 8% 82 I
#os ’ 0 ! o L\
= [ zvents 11,790 856,640 32.54% singlets A 05 05 16 15 20 05 05 1o 15 20
[Y S—— Fsca 10%) ssca(ione)
=[] singlets-+ 10,436 855,691 2.98% RSP
= ek 2,519 2,147,267 177%
g B0 oazio 0
[Jrscs 2,519 852,993 3.10% B e . o } BEA
5 5 o
O sscH 2,518 816,110 8.14% . 3 o ,
0 0
DBLQ.H 2,516 2,299,107 1.33% 100 107 10t 40P Dwn - 100 10?2 10t 10
auin s o
[mEES 2,520 2,231,868 1.76%
oatsi0 osssio oe1310 4
[ 2,508 2,454,312 1.78% oo 800 0 VA
£ 1o 5 o0 % 400
[[]wzH 2,506 2,325,277 1.58% & o & 8 20
o i ) . 2]
v+ 2,523 2,661,919 235% PRI W @ e o w00t w0t
wia waa wsa
£ [singlets-a 10,375 732,734 3.37%
2 et-a 2,436 2,127,868 2.19% oatsio
D ! ) ! N 20 041310 AM 041310 AM
FSC-A 2,496 731,005 3.50% F1o . i 100 §5¢H 40 FSCH
g i M L
S0 & 3 2
SECA 2,49 741,036 7.85% H @ ¢ s §®
B os
0
DBL}; 2,499 2,273,025 2.12% 00 singlets-H %6505 10 15 20 00 05 10 15 20
05 05 1o 15 20 FscH 1076) s5cH 10°)
[Jows-a 2,499 2,207,381 2.06% FscH 1079)
WiZ-A 2,481 2128075  1.90% — I g _ St
: z re
s 2,480 2436205 248% o I L v
3 400 3 s00 8
VLL-A 2,500 2,248,821 2.36% 20 . . | . |
T s 012 0t 100 R
BLIH BL2H B
ostzt0 oassio oissio
1000 VL1-H VL2-H 600 VL3-H
% 500 % 500 § 400
3 3 8 200
0 b 0 0
W 1R 0t W @ 0 e o 1@ 0t
freee wan waH
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Local Statistics Local statistics are plot-specific and display gating hierarchy specific to the
selected plot. In the example below, the gating hierarchy specific to the BL1-A plot
(parent and children data) is displayed.

Parameters: BL1-A vs Count
Gate: Singlets-A

Experiment Name: 4 Peak Beads
Speciman Name: Specimen
Sample Name: 20100420

Mame Event Count BL1-A Mean

& [Jan events 12012 1,042,578
= [ singlets 10,281 687,482

= [Oetea 2552 2,047,367

FSC-A 2,552 2,047,387

SSCA 2882 2,047,367
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BLI-A % CV.

196.13%
142.25%
2.00%
2.00%

2.00%

SEL- A (LOE)
(= -

=

TR
100 ]
E T a0 ]
g = : 3] |
n L 1} L US|
00 &5 14 15 20 08 0% 18 15 30
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Displaying
Statistics

Displaying Local Statistics

Select a plot and click on the Statistics icon in the Insert tab of the Ribbon menu to
insert a Local statistics box for that plot.

Alternatively, right-click on a plot and select Statistics.

Scatter - test sample

250 1 |
Cut Cirl+X
200 - Copy Ctri+C
= 150 ] Dele?e ) Del
Duplicate
Save As...
100 4
50
0o 4
o k] 4 New Gate 3
10 10 10 1 Set Population »
BL2-A

Customize...

Displaying Global Statistics

Click on the Workspace and then click on the Statistics icon in the Insert tab of the
Ribbon menu to insert a Global statistics box.

Alternatively, right-click on the Workspace and choose Insert » Statistics to insert
a global statistics box.

Select All Chrl+4

Globally Uss Compensation

Resat Compensation Matrx

Insert 3 Histogram Plat
Dot Plot
Density Plot

Text
Image
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Customizing
Statistics

130

To customize statistics boxes, right-click the statistics box, and then select

Customize.
T
F—— 9 A number of standard statistics
e e measurements are available:

=0 ¢ Event Count

Header

N O .

Tung i - e Median

(B)7)u) A~ &~ Asemple [ Time Recordedt

Population . Mean

Tahoma v|[s || Show

nt Count [¥] Event Percent Paren
A Ore e Blormt ot e Event Percent Parent
[CMean [ standard Deviation
e e Event Percent Total
Concentration (ev/ul)
o o e Standard Deviation
vadth: |0 2o
e  Coefficient of Variation
= e Concentration (ev/uL)

Options dialog box.

\_ Note: You can change the default statistics using the Styles tab in the
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Managing Experiments

Experiment
Explorer

The Experiment Explorer is used to manage experiments. Each Experiment is
associated with an Instrument Setting and a Workspace. There can be more than one

experiment in the Explorer, each experiment can have more than one Specimen,
and each Specimen can have more than one Sample. Each Sample is associated

with its own FCS file.
Experiment Explorer
| E My Experiments
4 ) Experiment 1
m Workspace
E"' Instrument Settings
lil Compensation

F | Specimen

» Eﬂ Sample 1
UH Sample 2
4 | Experiment 2
E Workspace
[:} Instrument Settings
I.' Compensation
4 L. Specimen
UH Sample 3
UH Sample 4

4 Experiment Folder
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In this example, there are two Experiments
(Experiment 1 and Experiment 2) in the
Experiment Explorer.

e Experiment 1 and Experiment 2 have their
unique Workspace and Instrument
Settings.

e Sample 1 has recorded data (), while
Samples 2, 3, and 4 do not have data

associated with them (Uﬂ').

e Sample 1 has its unique Instrument
Settings as indicated by the bold Sample
name (Lh Sample)

e An asterisk following the Sample name

(I sample*) indicates that the Workspace
layout for that Sample has been modified
and is unique to that Sample.

e Sample 2 is associated with the default
Instrument Settings as indicated by
Sample name that is not bold (UH Sample 2),

e Visual cue (/*)) indicates that Sample 1 is
active.
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Managing ¢ Workspace layout and the Instrument Settings are the same for the various

Experiments Specimens and Samples that are collected for a particular Experiment.
Therefore, all Samples for Experiment 1 (Sample 1 and Sample 2) in the
example on the previous page have the same Workspace and Instrument
Settings.

¢ However, you may modify Instrument Settings and Workspace layout at the
Sample-specific level. Sample-specific (Local) Workspace and Instrument
Settings are denoted by an asterisk and bold font, respectively (see previous

page).
e Double-clicking on Workspace opens the Experiment template, which

contains plots, statistics, text, or images. These plots will not be populated
with any data until they are associated with a Sample.

o If the layout of the Workspace has been modified, you will be prompted with
the option to save the changes to the Workspace when attempting to open
another Sample or Workspace from another Experiment.

<\\;§, Note: By default all Samples share the same Workspace and Instrument

—'  Settings as their parent Experiment. However, when a new Sample is
created, the Workspace layout is copied to the Sample. The Workspace
template remains intact.
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Software Administration

Several functions of the Attune® Cytometric Software are available only to the
software administrator or to users designated by the administrator (Administrator
Options), while General Options are user-specific and available to every user.

Administrator Administrator options are only accessible to the software administrator or
designated users.

1. Click Options (j) shortcut button in the Quick Access toolbar. Alternatively,
click Options under Global in the Home tab.

e ] @

Options  Main  Transaction

Options

Menu Log
Global
Options window opens.
= Options El
Options
You can use this to manage users and general application settings.
General C v - = ;
-~ Advanced options for working with Attune™ Cytometric Software
Administrator r
User Management Folder Locations
Styles Users: [ ct\Program Files\Applied Biosystems\Attune\Users\ |
Resources Shared Templates: | €:\Program Files\Applied Biosystems\Attune\Shared Templates| | Browse...
Performance Tracking: | C:\Program Files\Applied Biosystems\Attune\Performance Tracking) |
Hepwits: [ c:tprogrem Filesipplied Biosystems fittuneReporis\ |
Other Settings
Institution Name: [ |
Instrument Name: [ |
Instrument Serial Number: | NA |
——

2. Click Administrator to assign the following folders:
e Users
e Shared Templates
e Performance Tracking
e Reports

The administrator can also designate the Institution name, Instrument name,
and set the Instrument Serial Number.

Assigning Data 1. Click Options (j) shortcut button in the Quick Access toolbar. Alternatively,
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Storage Paths click Options under Global in the Home tab. Only a user with Administrator
privileges can assign data storage paths.

Options window opens.
2. In the Options window, click Administrator.

3. Assign the appropriate path using the Browse function.

@ IMPORTANT! When reassigning data storage paths, the administrator
must copy the existing files from the original location to the new one.

Adding Users 1. Click Options (;-E) shortcut button in the Quick Access toolbar.

Alternatively, click Options under Global in the Home contextual tab. Only a
user with Administrator privileges can add new users and assign user
privileges.

2. Click User Management.

®_ Options E|
Options

“You can use this to manage users and general application settings.

General
Snere g,\, Manage users working with Attune™ Cytometric Software
Admiristrator -

UserManagement: User Name Full Name Phone Number Access Type
Styles & Admin Administrator Administrator o
Mike Mike Doz Operator o

Resources

. oo

—
3. Select New User.
u User X
User
Use the following options to set user information and access privileges.
User Name: | Mike |
Full Name: [ Mike Doe |
Phone Number: | |
Access Type: | Operator v
[JEnable Viewing System Transactions
Enable Viewing User Transactions
Enable Running Baseline Calculations
Enable running Performance Test
Notes:
(o]

134 Attune® Acoustic Focusing Cytometer User Guide



Removing Users

Changing and
Resetting
Passwords

Changing User
Privileges

Changing Default
Styles

Enter appropriate information and permissions.
Assign password by selecting Change Password.

Enter new password and confirm.

Click Options (J.*) shortcut button in the Quick Access toolbar. Alternatively,
click Options under Global in the Home contextual tab. Only a user with
Administrator privileges can remove users.

Click User Management.

Select the user you want to remove and click the Trash icon ().

Click Options (J:.') shortcut button in the Quick Access toolbar. Alternatively,
click Options under Global in the Home contextual tab.

Click User Management.
Select the user from the list displayed.

Click Change Password to assign a new password or click Reset Password to
reset an existing password.

Enter new password and confirm.

Note: If a password was not assigned to a new account, the user will be
prompted to create a password when logging in for the first time.

@ IMPORTANT! User accounts are stored in an encrypted file. Lost and

forgotten passwords cannot be recovered. An administrator must reset the
password if a user forgets their password.

Click Options (-ﬁ) shortcut button in the Quick Access toolbar. Alternatively,
click Options under Global in the Home contextual tab.

Click User Management to select the user from the list displayed.

Click Properties to open the User dialog box and select the desired access type
(Administrator, Operator, Service) from the Access Type dropdown menu.

Check the appropriate boxes to assign user privileges. You can assign the
following user privileges:

e Enable Viewing System Transactions
e Enable Viewing User Transactions

¢ Enable Running Baseline Calculations
¢ Enable Running Performance Test

Click Options (J.*) shortcut button in the Quick Access toolbar. Alternatively,
click Options under Global in the Home contextual tab.

Click Styles to select the desired default styles for charts, text objects,
statistics, and gates.

Attune® Acoustic Focusing Cytometer User Guide 135



General Options

General Options are specific to each user. You can use this tab to set the default
Workspace (*.gws) and Instrument Settings (*.gis) used when creating new

experiments, as well as the Templates folder.

1. To access General Options, click Options (j) shortcut button in the Quick
Access Bar in the upper-left corner of the screen.

Alternatively, click Options under Global in the Home tab.

[ ] &

®_ Options

Options

General
Administrator
User Management
Styles

Resources

‘Options

Main  Transaction
Manu Log
Global

Options window opens.

You can use this to manage users and general application settings.

Default Files and Folders

Default Warkspace:

E Change the most popular options in Attune™ Cytometric Software
[ Catprogram Fikes\Appied B fune\Users\Admin| TemplatesDef|
fune\Users\Admin| TemplatesDef|

Default Instrument Settings: | C:Program Files)\Applied B

Templates Folder:

| C:\Program Files\Applisd Biosystems\Attune\Users\Admin|Templates), \

Other Options

Default Sample Name: [

Default Specimen Name: |

[[]5how sample's recordad date time in experiment axplarer

.

2. Click General to designate the default Workspace, instrument settings, and
templates folder, as well as changing the Default Sample and Specimen

names.
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Modes of Operation

The functions of the Attune® Acoustic Focusing Cytometer are controlled by
Attune® Cytometric Software. The system has three cycles:

e Startup
e Collect-Run-Rinse
e Shutdown
Startup Cycle The Startup cycle is performed at the beginning of each day to ensure that all

fluidic lines are clean, and that the fluidic lines and the system’s two pumps are
filled with fresh focusing fluid.

Collect-Run-Rinse The Collect-Run-Rinse cycle is performed during normal operation with data
Cycle collection. In the Run portion of the cycle, there are two modes for data collection:
standard and high sensitivity, each with several sample collection rate.

@ IMPORTANT! We recommend that you sanitize the system between
users. See “Inter-User Wash Procedure” on page 17.

Shutdown Cycle The Shutdown cycle is performed at the end of each day to ensure that all sample
fluid and dyes have been removed from the system, and that the fluidic lines and
two pumps are filled with Attune® Shutdown Solution to prevent build up of salt
deposits and cellular debris.

Automatic Shutdown can take up to 30 minutes.
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Fluidics Functions Inaddition to the Modes of Operation described on the previous page, the
Attune® Cytometric Software controls the fluidics functions of the Attune®
Acoustic Focusing Cytometer. These functions are:

e De-bubble is a user-initiated function for clearing bubbles in the fluidics lines
of the cytometer.

e Wash is a user-initiated system cleaning between sticky samples. This
function requires user-supplied 10% bleach solution.

@ IMPORTANT! We recommend that you sanitize the system between
users. See “Inter-User Wash Procedure” on page 17.

¢ Unclog function is a user-initiated back flush operation to remove clogs from
the sample probe and flow cell.

¢ Rinse automatically flushes the system between samples to minimize
carryover. This function can also be user-initiated. During the rinse, the Red
Status Indicator Light will stop blinking when it is okay to load a new sample
onto the SIP.

¢ Shutdown is an automated function that initiates the cleaning cycle and post-
cleaning rinse. This mode requires user supplied bleach, Attune® Wash
Solution, and Attune® Shutdown Fluid.

e Startup is an automated function that starts the fluidics, optics, and
electronics of the Attune® Acoustic Focusing Cytometer. The Startup functions
include priming the instrument fluidics and allowing the laser time to warm.

e Stop is used to end all data collection.

e Clear is used to delete the data from the screen. It refreshes the Workspace
while the instrument is in Run or Record mode.

You can initiate some of the fluidics functions by clicking Functions in the
Instrument Status Bar, and then selecting the appropriate function from the menu
items. Shutdown can only be run from the Login Screen.

De-bubble
Wash
Unclog
Rinse
Skartup
Skop

Clear Error

Functions &

@ IMPORTANT! The lasers are powered down during the Wash and
Shutdown cycles. The lasers must warm up for at least 10 minutes before
running additional samples.
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Appendix E: Troubleshooting

This section includes the following topics:

e Tips to help you troubleshoot your experiment

e Technical Assistance Information

E, Note: For Software Troubleshooting, refer to the Attune® Cytometric
—  Software Release Notes or contact customer support.
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Cytometer Troubleshooting

Observation

Possible Causes

Recommended Solutions

No events are
displayed when in
Run mode

Threshold is not set correctly

Ensure that threshold is set correctly and/or
for the right parameter on the instrument
configuration panel.

Threshold level is too high

Lower the threshold using the slider bars on
the instrument configuration panel.

PMT voltages set too high or too
low for parameter

Optimize PMT setting by adjusting voltages
up or down.

Sample may be too dilute

Increase the sample flow rate.

No sample in tube

Add sample or install new sample tube.

Clog in Sample Injection Port
(SIP)

¢ Run Unclog function

e Run4 mL of Attune® wash solution using
standard sensitivity with 500 pL/minute
flow rate.

Incorrect filter in detection
channel

Verify standard optical configuration.

Gating issue

Verify that the plots are set to all events
and/or the gate logic is correct.

Laser is not functioning

Verify laser function by re-running the
Performance Tracking function. If the problem
persists, contact Technical Support.

Cells have been lysed

e Ensure that the cells have not been lysed
or broken up.

¢ Ensure that your sample contains cells.

Population is off scale

e Adjust the axis to view the population.

e If events are detected in the counter,
ensure that the axis is set correctly

Sample is not aspirated or only
partially aspirated

¢ Ensure that the 1 mL sample syringe is
sealed properly.

e  Faulty pinch — contact Technical Support.

Run button is not

Focusing fluid tank is empty

e Fill the focusing fluid tank.

available e Ensure that the fill lines and fluid level
detectors are plugged in completely.
Lid interlock is not triggered Ensure that the lid is properly closed.
Tube lifter is not engaged Push tube lifter to “up” position.
Instrument is powered off Turn on the instrument.
Startup not completed Perform Startup.
USB cable not connected Ensure that the USB cable is plugged in to the
instrument and the computer.
Sample tube is not selected Select the sample tube.
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Observation

Possible Causes

Recommended Solutions

Computer is not
communicating with
the instrument

USB cable not fully plugged in

Examine the USB plug in the back of the
instrument and the computer.

Faulty USB cable

Contact Technical Support.

USB port changed from the
original port

Try different USB ports until communication
is restored. If the problem persists, reinstall the
USB drivers.

Instrument and/or
computer has no
power

Power supply not plugged into
the appropriate outlet

Ensure that the instrument and/or computer
are plugged into the appropriate outlet.

No power at the outlet

Make sure that the outlet is functioning
properly and the circuit breaker is not tripped.

Faulty power supply

Contact Technical Support.

No fluorescent signal

Incorrect parameter is selected

Ensure that the correct parameter is selected.

Incorrect filter is installed

Verify that appropriate filters are installed for
each detection channel.

Laser is not functioning

Run Performance Test to verify laser function.
If laser is not functioning properly, contact
Technical Support.

Incorrect fluorochrome

Verify that the reagent excitation/emission
spectra match the collection filter set.

Reagent has degraded

Restain your sample with fresh reagents.

Laser delay is incorrect

Run Performance Test.

Event rate is too high

Air bubble in focusing fluid
filter or flow cell

Run De-bubble function.

Threshold is set too low

e Increase the threshold level to reduce
noise.

e Ensure that the threshold parameter is not
set to “Ignore.”

PMT voltage for threshold is too
high

Lower the PMT voltage for threshold
parameters.

Sample may be too concentrated

¢ Lower the sample flow rate.
e Dilute the sample.

Sample flow rate is too high

Lower the sample flow rate and/or change the
transit time to standard sensitivity mode.

Bacterial contamination

Ensure that the sample is not contaminated.
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Observation

Possible Causes

Recommended Solutions

Event rate is too low

Threshold level is too high

Lower the threshold level.

PMT voltage for the threshold
parameter is set too low

Set the PMT voltage higher for threshold.

Sample injection port (SIP) may
be clogged

Run Unclog function or run Wash cycle. If the
problem persists, contact Technical Support.

Sample is not adequately mixed

Mix the sample to suspend the cells.

Sample is too dilute

Increase the sample flow rate.

Loose sample syringe

Check the sample syringe for leaks and tighten
if necessary.

Low event rate with
high %CV

Bubbles in flow cell

Run De-bubble function.

Erratic event rate

Partial clog in the flow cell

Run Wash cycle. If the problem persists,
contact Technical Support.

Sample has large clumps

Filter the sample prior to loading to the
instrument.

Loose syringe

Check syringes for leaks, tighten if necessary.

Focusing Fluid pump or Sample
pump is not delivering the
correct volume and/or is
operating at inaccurate speed

Contact Technical Support.

Contaminated sample

Prepare new sample using clean tubes.

Bubble in fluidics lines

Run De-bubble function.

Sample is not
aspirating

Loose sample syringe

Check the sample syringe for leaks and tighten
if necessary.

Defective sample syringe

Replace sample syringe.

Pinch in valve tubing

Contact Technical Support.

Clog in SIP tube

Run Unclog function.

Defective pinch valve

Contact Technical Support.

Scatter pattern is
unclear

Instrument settings are not
optimized

¢ Optimize experiment parameters for cell
type.
e Ensure that the axis have the same scale.

Cells were fixed

Some reagents used for fixing and
permeabilizing the cells alter scatter patterns.
Prepare new sample using different reagents
for fixing and permeabilizing the cells.

Bubbles in the fluidics system

Run De-bubble function.

142

Attune® Acoustic Focusing Cytometer User Guide



Observation

Possible Causes

Recommended Solutions

High %CV with
sample

Poor sample preparation

® Repeat the sample staining procedure.
e  Optimize reagent stain conditions.

Flow cell may be dirty

Perform system wash or Shutdown cycle.

Air bubble in flow cell

Run De-bubble function.

Incorrect laser delay (blue
channels only)

Clean the cytometer optics and re-run
Performance Test.

Sample aspirated,
then backfilled into
sample tube

Clog in the sample line

Run Unclog function.

Pinch valve error

Contact Technical Support.

Pump error

Contact Technical Support.

Long delay between
sample aspiration and
events appearing on
screen (normally
events appear in

~10 seconds)

Sample syringe is leaking

Ensure that the sample syringe is sealed
properly.

Partial clog in the fluidics
system

Run Unclog function.

Sample probe is not
centered in the sample
tube

SIP tube is bent

Carefully bend the SIP tube in place.

SIP tube is faulty

Contact Technical Support.

Sample tube is not aligned
vertically on tube lifter

Readjust the sample tube on the tube lifter.

Focusing fluid pump
does not shut off

Focusing fluid filter is clogged

Replace the focusing fluid filter

Focusing fluid reservoir level
sensor is malfunctioning

Perform Stop function. If the problem persists,
shut off the instrument and contact Technical
Support.

Fluid is leaking from
the base of the
instrument or into the
drip tray

Crack in fluidics tank

Replace the damaged fluidics tank.

Snap fitting is broken or

dripping

Contact Technical Support.

Fluidics valve failure

Turn off the instrument and contact Technical
Support.

10 mL or 1 mL syringe seal is
broken

Contact Technical Support.

Focusing fluid filter is leaking

Replace the filter.
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Performance Tracking Troubleshooting

Observation

Possible Causes

Recommended Solutions

High APMT in a
single channel

Improper bandpass filter in
channel

Check the optical configuration.

Improper dichroic mirror
placement

Check the optical configuration.

Scratched or defective bandpass
filter or dichroic mirror

Clean filters; if problem persists, contact
Technical Support.

PMT malfunction

Contact Technical Support.

Incorrect performance tracking
beadlot used

Verify the lot number and download the
correct lot information.

High APMT in all Incorrect bead sample is used Prepare a new bead sample.
channels Incorrect performance tracking Verify that the software has the appropriate
beadlot used beadlot data installed and re-run the
Performance Test.
Bead sample removed before the Re-run the Performance Test in its entirety
Performance Test was completed | using the same bead sample.
Bead sample too dilute to register | Prepare a fresh bead sample according
enough events following manufacturer’s
recommendations.
Clog or partial clog in the flow cell | Run Unclog function.
Particle(s) stuck in the flow cell Run long wash cycle.
Bubbles in the system Run De-bubble function.
—~APMT in all channels | Low or no laser power Contact Technical Support.

for a single laser

Wrong optical configuration for a
single laser

Check the optical configuration.

Laser is misaligned

Contact Technical Support.

Bubbles in the system

Contact Technical Support.

High %HPCV in a
single channel for a
single laser line

Dirty emission filter

Inspect and clean filter.

Incorrect emission filter

Check the optical configuration.

PMT malfunction

Contact Technical Support.

Fluidics system is dirty

Run Wash function.

High %HPCV in all
channels for a single
laser line

Improper filter placement

Check the optical configuration.

Laser is misaligned

Contact Technical Support.

Laser delay calculated incorrectly

Contact Technical Support.

Bubbles in the system

Run De-bubble function.

High %HPCV in two
channels for a single
laser line

Improper dichroic mirror
placement

Check the optical configuration.

Emission filters swapped

Check the optical configuration.
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Sample Troubleshooting

Observation

Possible Causes

Recommended Solutions

Weak or no
fluorescence from the
sample

Insufficient antibody present in
sample

Ensure adequate antibody concentration for
the total number of cells stained by titration

Target may not be accessible to
the antibody (i.e., intracellular
target)

Ensure that the fixation and permeabilization
conditions are optimized for the target.

Inaccurate choice of
fluorochrome

Use bright fluorochromes for dim markers

Too much spectral overlap

Use fluorochromes that are spatially
separated.

Incorrect compensation

Ensure that the positive single color control is
set up correctly on the flow cytometer and
gated/compensated correctly to capture all the
events.

Target not present or expressed
poorly

Ensure that the sample expresses the target
protein and allows its detection.

Experiment is not optimized
correctly

Use positive control to set PMT voltage,
threshold etc.

Reagent has degraded

Restain sample with fresh reagent.

Primary antibody is not
compatible with the secondary
antibody.

Ensure that the secondary antibody was raised
against the species in which the primary
antibody was raised.

Lasers are not aligned properly

Re-run the Performance Test; if it fails, contact
Service.

High fluorescence
from the sample

Antibody concentration is too
high

Reduce the amount of antibody added to the
sample.

Excess antibody is trapped
inside the cell

Ensure adequate washing of the sample with
wash buffer containing permeabilization
reagent.

Inadequate blocking of the
sample

Perform the blocking step prior to staining the
cells.

Experiment is not optimized
correctly

Readjust PMT settings to ensure that all
populations are on scale.

Two or more cell
populations are
observed when there
should be only one

Inaccurate gating

Revise gate to only include the population of
interest.

Target protein is expressed on
multiple cells

Verify the expression level and ensure
adequate cell identification and separation.

Cell doublets

¢  Filter cells to remove clumps.
¢ Dilute the sample to reduce coincidence.

Non-specific staining due to
dead cells

Use an appropriate dead cell stain to eliminate
dead or dying cells.
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Appendix F: Limited Product Warranty

Limited warranty. Life Technologies warrants that all standard components of its Attune® Acoustic
Focusing Cytometer will be free of defects in materials and workmanship for a period of one (1) year after
the date of installation, and the software will be free of substantial programming errors or defects when
properly installed. However, this warranty will not last longer than 15 months from the date of shipment.
Life Technologies also warrants that the instrument (including software) will perform in accordance with
its published specifications when delivered. Life Technologies will repair or replace, at its discretion, all
defective components during this warranty period. Life Technologies reserves the right to use new,
repaired, or refurbished instruments or components for warranty service agreement replacements. Repair
or replacement of products or components that are under warranty does not extend the original warranty
period. Unless a different written warranty is included with product literature, Life Technologies warrants
that each consumable supplied with the instrument will meet its specifications stated in its published
catalogs and any associated supplementary terms relating to the product. This warranty lasts from the
delivery of the consumable until either the consumable’s expiry or “use by” date, or, if no expiry or “use
by” date is specified, for 12 months from the delivery of the consumable, provided, however, that the
warranty will not last for more than thirty (30) days after Customer opens consumable’s original container.
Life Technologies does not warrant that the operation of the instrument or its operating software will be
uninterrupted or error free. Warranty claims must be made within the applicable warranty period.

Warranty exceptions. The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation with incompatible solvents or samples in the system;
operation outside of the specifications or not in conformance with the instructions; use in combination with
software or products not supplied or authorized by Life Technologies; modification or repair of the product
not authorized by Life Technologies, relocation or movement of the instrument by Customer or any third
party not acting on behalf of Life Technologies; or intrusive activity, including without limitation computer
viruses, hackers or other unauthorized interactions with instrument or software that detrimentally affects
normal operations. Without limiting the above mentioned, computer hardware, monitors, accessories,
software or other products not purchased from or supplied by Life Technologies (Non-LIFE Product”) are
not covered under the foregoing warranty even if such Non-LIFE Product is integral to functional use of a
Life Technologies product.
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Warranty limitations. THE WARRANTIES IDENTIFIED ABOVE ARE LIFE TECHNOLOGIES’ SOLE AND
EXCLUSIVE WARRANTIES WITH RESPECT TO SUCH PRODUCTS AND ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, ALL OF WHICH OTHER WARRANTIES ARE EXPRESSLY
DISCLAIMED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT, OR
REGARDING RESULTS OBTAINED THROUGH THE USE OF ANY PRODUCT (INCLUDING,
WITHOUT LIMITATION, ANY CLAIM OF INACCURATE OR INCOMPLETE RESULTS), WHETHER
ARISING FROM A STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE
OF TRADE. WITHOUT LIMITING THE FOREGOING, IN NO EVENT SHALL LIFE TECHNOLOGIES BE
LIABLE FOR CONSEQUENTIAL, INDIRECT, PUNITIVE, INCIDENTAL, OR OTHER SPECIAL
DAMAGES SUSTAINED BY THE BUYER OR ANY OTHER PERSON OR ENTITY, WHETHER OR NOT
FORESEEABLE AND WHETHER OR NOT LIFE TECHNOLOGIES IS ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES ARISING FROM OR RELATED
TO LOSS OF USE, LOSS OF DATA, OR FOR LOSS OF REVENUE OR OTHER FINANCIAL LOSS. NO
EMPLOYEE OR REPRESENTATIVE OF LIFE TECHNOLOGIES HAS ANY AUTHORITY TO MODIFY
THE TERMS OF THIS LIMITED WARRANTY STATEMENT AND ANY SUCH MODIFICATION MADE
BY ANY EMPLOYEE OR REPRESENTATIVE OF LIFE TECHNOLOGIES WILL NOT BE BINDING ON
LIFE TECHNOLOGIES, UNLESS IN A WRITING SIGNED BY AN EXECUTIVE OFFICER OF LIFE
TECHNOLOGIES. THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM LIFE
TECHNOLOGIES AND IS NOT TRANSFERABLE. THE FOREGOING LIMITATIONS OR EXCLUSIONS
OF WARRANTIES, LIABILITY, REMEDIES, OR DAMAGES SET FORTH ABOVE SHALL NOT APPLY TO
THE EXTENT PROHIBITED BY LAW.
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Appendix G: Safety

This section includes the following topics:
e Safety conventions used in this document
¢ Symbols on instruments
e Safety labels on instruments
¢  General instrument safety
¢ Chemical safety
¢ Chemical waste safety
o Electrical safety
e Physical hazard safety
e Biological hazard safety
o Laser safety
¢  Workstation safety
e Safety and electromagnetic compatibility (EMC) standards
e SDSs
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Safety Conventions Used in this Document

Safety Alert Words Four safety alert words appear in Life Technologies user documentation at points
in the document where you need to be aware of relevant hazards. Each alert
word-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular
level of observation or action:

Definitions

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate installation, or safe use of a chemical.

CAUTION! - Indicates a potentially hazardous situation that, if not
avoided, may result in minor or moderate injury. It may also be used to
alert against unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not
avoided, could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not
avoided, will result in death or serious injury. This signal word is to be
limited to the most extreme situations.

> B> B o

Except for IMPORTANT! safety alerts, each safety alert word in a Life
Technologies document appears with an open triangle figure that contains a
hazard symbol. These hazard symbols are identical to the hazard icons that are
affixed to Applied Biosystems® instruments (see “Safety Symbols” on page 151).
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Symbols on Instruments

Electrical Symbols The following table describes the electrical symbols that may be displayed on

on Instruments Applied Biosystems® instruments.

Symbol Description

I Indicates the On position of the main power switch.

O Indicates the Off position of the main power switch.

Indicates a standby switch by which the instrument is switched on to
the Standby condition. Hazardous voltage may be present if this
switch is on standby.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground
reference of another instrument. This is not a protected ground
terminal.

J—-
=
@ Indicates a protective grounding terminal that must be connected to
. e
TN
—

earth ground before any other electrical connections are made to the
instrument.

Indicates a terminal that can receive or supply alternating current or
voltage.

Indicates a terminal that can receive or supply alternating or direct
current or voltage.
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Safety Symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems® instruments. Each symbol may appear by itself or in
combination with text that explains the relevant hazard (see “Safety Labels on
Instruments” on page 152). These safety symbols may also appear next to
DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other
product-support documents.

Symbol

Description

Indicates that you should consult the manual for further information
and to proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed
with appropriate caution.

Indicates the presence of a hot surface or other high-temperature
hazard and to proceed with appropriate caution.

Indicates the presence of a laser inside the instrument and to proceed
with appropriate caution.

Indicates the presence of moving parts and to proceed with
appropriate caution.

Indicates the presence of a biological hazard and to proceed with
appropriate caution.

2P B>

Indicates the presence of an ultraviolet light and to proceed with
appropriate caution.

Environmental The following symbol applies to all Applied Biosystems® electrical and electronic

Symbols on
Instruments

products placed on the European market after August 13, 2005.

Symbol

Description

Do not dispose of this product as unsorted municipal waste. Follow
local municipal waste ordinances for proper disposal provisions to
reduce the environmental impact of waste electrical and electronic
equipment (WEEE).

European Union customers:

Call your Customer Service representative for equipment pick-up and
recycling. See www.appliedbiosystems.com for a list of customer
service offices in the European Union.
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Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be
displayed on Applied Biosystems® instruments in combination with the safety
symbols described in the preceding section.

Hazard
Symbol

English

Francais

/N

CAUTION! Hazardous chemicals. Read the
Safety Data Sheets (SDSs) before handling.

ATTENTION! Produits chimiques
dangereux. Lire les fiches techniques de
stireté de matériels avant toute manipulation
de produits.

CAUTION! Hazardous waste. Refer to
SDS(s) and local regulations for handling and
disposal.

ATTENTION! Déchets dangereux. Lire les
fiches techniques de stireté de matériels et la
régulation locale associées a la manipulation
et I’élimination des déchets.

/2N

DANGER! High voltage.

DANGER! Haute tension.

WARNING! To reduce the chance of
electrical shock, do not remove covers that
require tool access. No user-serviceable parts
are inside. Refer servicing to Life
Technologies qualified service personnel.

AVERTISSEMENT! Pour éviter les risques
d’électrocution, ne pas retirer les capots dont
I'ouverture nécessite 1'utilisation d’outils.
L’instrument ne contient aucune piece
réparable par l'utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié venant de chez Life Technologies.

DANGER! Class 3B visible and/or invisible
laser radiation present when open. Avoid
exposure to beam.

DANGER! Rayonnement visible ou invisible
d’un faisceau laser de Classe 3B en cas
d’ouverture. Evitez toute exposition au
faisceau.

e B

CAUTION! Moving parts. Crush/pinch
hazard.

ATTENTION! Pieces en mouvement, risque
de pincement et/ou d’écrasement.

152
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General Instrument Safety

Moving and Lifting
the Instrument

Moving and Lifting
Stand-alone
Computers and
Monitors

Operating the
Instrument

Cleaning or
Decontaminating
the Instrument

WARNING! PHYSICAL INJURY HAZARD. Use this product only as
specified in this document. Using this instrument in a manner not specified
by Life Technologies may result in personal injury or damage to the
instrument.

/N

CAUTION! PHYSICAL INJURY HAZARD The instrument is to be
moved and positioned only by the personnel or vendor specified in the
applicable site preparation guide. If you decide to lift or move the
instrument after it has been installed, do not attempt to lift or move the
instrument without the assistance of others, the use of appropriate moving
equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or
lifting an instrument may require two or more persons.

/N

WARNING! Do not attempt to lift or move the computer or the monitor
without the assistance of others. Depending on the weight of the computer
and/or the monitor, moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

Do not lift an object and twist your torso at the same time.
Keep your spine in a good neutral position while lifting with your legs.

Participants should coordinate lift and move intentions with each other before
lifting and carrying.

Instead of lifting the object from the packing box, carefully tilt the box on its
side and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

Received instructions in both general safety practices for laboratories and
specific safety practices for the instrument.

Read and understood all applicable Safety Data Sheets (SDSs). See “SDSs” on
page 160.

CAUTION! Using cleaning or decontamination methods other than those
recommended by the manufacturer may compromise the safety or quality
of the instrument.
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Chemical Safety

Chemical Hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer
Warning to the Safety Data Sheet (SDS) provided by the manufacturer, and observe
all relevant precautions.

A WARNING! CHEMICAL HAZARD. All chemicals in the instrument,
including liquid in the lines, are potentially hazardous. Always determine
what chemicals have been used in the instrument before changing reagents
or instrument components. Wear appropriate eyewear, protective clothing,
and gloves when working on the instrument.

A WARNING! CHEMICAL STORAGE HAZARD. Never collect or store
waste in a glass container because of the risk of breaking or shattering.
Reagent and waste bottles can crack and leak. Each waste bottle should be
secured in a low-density polyethylene safety container with the cover
fastened and the handles locked in the upright position. Wear appropriate
eyewear, clothing, and gloves when handling reagent and waste bottles.

General Safety To minimize the hazards of chemicals:

Guidelines ¢ Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “SDSs,” page 160)

¢ Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

¢ Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

o  Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

e Comply with all local, state/provincial, or national laws and regulations
related to chemical storage, handling, and disposal.
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Chemical Waste Safety

Chemical Waste
Hazard

Chemical Waste
Safety Guidelines

Waste Disposal

CAUTION! HAZARDOUS WASTE. Refer to Material Safety Data Sheets
and local regulations for handling and disposal.

To minimize the hazards of chemical waste:

Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store,
handle, or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks
from the primary container. Both containers must be compatible with the
waste material and meet federal, state, and local requirements for container
storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood). For additional
safety guidelines, consult the SDS.

Handle chemical wastes in a fume hood.
After emptying the waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national
environmental and health regulations.

If potentially hazardous waste is generated when you operate the instrument, you
must:

Characterize (by analysis, if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and
disposed of according to all local, state/provincial, and/or national
regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Electrical Safety

Fuses

Power

/N

DANGER! ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Attune® Acoustic Focusing Cytometer without its
instrument panels in place. Do not remove instrument panels.

High voltage contacts are exposed when instrument panels are removed
from the instrument.

WARNING! FIRE HAZARD. For continued protection against the risk of
fire, replace fuses only with fuses of the type and rating specified for the
instrument.

DANGER! ELECTRICAL HAZARD. Grounding circuit continuity is vital
for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

DANGER! ELECTRICAL HAZARD. Use properly configured and
approved line cords for the voltage supply in your facility.

> P P

DANGER! ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage Rating The Applied Biosystems® Attune® Acoustic Focusing Cytometer has an installation
(overvoltage) category of II, and is classified as portable equipment.
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Physical Hazard Safety

Moving Parts % WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and
cut. Keep hands clear of moving parts while operating the instrument.
Disconnect power before servicing the instrument.

Biological Hazard Safety

& WARNING! BIOHAZARD. Biological samples such as tissues, body
fluids, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial,
and/or national regulations. Wear appropriate protective eyewear,
clothing, and gloves. Read and follow the guidelines in these publications:

Inthe US.:

e U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories

(stock no. 017-040-00547-
4; www.cdc.gov/OD/ohs/biosfty/bmbl4/bmbl4toc.htm)

e Occupational Safety and Health Standards, Bloodborne Pathogens

(29

CFR§1910.1030; www.access.gpo.gov/nara/cfr/waisidx_01/29¢fr1910a_01.htm
1)

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

e Additional information about biohazard guidelines is available at:

www.cdc.gov

In the EU:

e Check your local guidelines and legislation on biohazard and biosafety
precaution, and the best practices published in the World Health Organisation
(WHO) Laboratory Biosafety Manual, third edition

www.who.int/cst/resources/publications/biosafety/ WHO_CDS_CSR_LYO_
2004_11/en/
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Laser Safety

Laser
Classification

Laser Safety
Requirements

Additional Laser
Safety Information
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The Attune® Acoustic Focusing Cytometer blue/violet configuration uses a
488nm, 20mW laser and a 405nm, 50mW laser, and the blue/red configuration
uses a 488nm, 20mW laser and a 638nm, 50mW laser. Under normal operating
conditions, the Attune® Acoustic Focusing Cytometer is categorized as a Class I
laser product. When safety interlocks are disabled during certain servicing
procedures and/or input/output optics covers are removed, the laser can cause
permanent eye damage, and, therefore, is classified under those conditions as a
Class 3B laser.

To ensure safe laser operation:

¢ The system must be installed and maintained by a Life Technologies Technical
Representative.

e Allinstrument panels must be in place on the instrument while the
instrument is operating. When all panels are installed, there is no detectable
radiation present. If any panel is removed when the laser is operating, you
may be exposed to laser emissions in excess of the Class 3B rating.

¢ Do not remove safety labels.

Refer to the user documentation provided with the laser for additional
information on government and industry safety regulations.

WARNING! LASER HAZARD. Lasers can burn the retina, causing
permanent blind spots. Never look directly into the laser beam. Remove
jewelry and other items that can reflect the beam into your eyes. Do not
remove the instrument top or front panels. Wear proper eye protection and
post a laser warning sign at the entrance to the laboratory if the top or
front panels are removed for service.

%g WARNING! LASER HAZARD. An overheated laser can cause severe
burns if it comes in contact with the skin. DO NOT operate the laser when
it cannot be cooled by its cooling fan. Always wear appropriate laser safety

goggles.
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Safety and Electromagnetic Compatibility (EMC]) Standards

U.S. and Canadian
Safety Standards

b

C us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
standards

C

This section provides information on:

¢ U.S. and Canadian safety standards
¢ Canadian EMC standard

e European safety and EMC standards
e Australian EMC standards

The Attune® Acoustic Focusing Cytometer has been tested to and complies with
standard:

UL 61010-1/CSA C22.2 No. 61010-1, “Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use, Part 1: General
Requirements.”

FDA “Radiation Control for Health and Safety Act of 1968 Performance Standard
21 CFR 1040.10 and 1040.11,” as applicable.

This instrument has been tested to and complies with ICES 001, Issue 3:
“Industrial, Scientific, and Medical Radio Frequency Generators.”

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards
EN 61010-1:2006, “Safety Requirements for Electrical Equipment for
Measurement, Control and Laboratory Use, Part 1: General Requirements.”

EN 60825-1, “Radiation Safety of Laser Products, Equipment Classification,
Requirements, and User Guide.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with
standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement,
Control and Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064,
“Limits and Methods Measurement of Electromagnetic Disturbance
Characteristics of Industrial, Scientific, and Medical (ISM) Radio frequency
Equipment.”
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SDSs

SDSs Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments
of hazardous chemicals to new customers. They also provide SDSs with the first
shipment of a hazardous chemical to a customer after an SDS has been updated.
SDSs provide the safety information you need to store, handle, transport, and
dispose of the chemicals safely. Each time you receive a new SDS packaged with a
hazardous chemical, be sure to replace the appropriate SDS in your files.

Obtaining SDSs You can obtain from Life Technologies the SDS for any chemical supplied by
Applied Biosystems®. This service is free and available 24 hours a day.

To obtain SDSs:

1. Go to www.lifetechnologies.com, click Support, and then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS
part number, or other information that appears in the SDS of interest. Select
the language of your choice, and then click Search.

3. Find the document of interest, right-click the document title, then select any of
the following:
¢ Open - To view the document
e  Print Target — To print the document
e Save Target As — To download a PDF version of the document to a
destination that you choose

@ IMPORTANT! For the SDSs of chemicals not distributed by Life
Technologies contact the chemical manufacturer.
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